Multi-Site Implementation Guide
Copyright © 2009 Infor

All rights reserved. The word and design marks set forth herein are trademarks and/or registered trademarks of Infor and/or its affiliates and subsidiaries. All rights reserved. All other trademarks listed herein are the property of their respective owners.

Important Notices

The material contained in this publication (including any supplementary information) constitutes and contains confidential and proprietary information of Infor.

By gaining access to the attached, you acknowledge and agree that the material (including any modification, translation or adaptation of the material) and all copyright, trade secrets and all other right, title and interest therein, are the sole property of Infor and that you shall not gain right, title or interest in the material (including any modification, translation or adaptation of the material) by virtue of your review thereof other than the non-exclusive right to use the material solely in connection with and the furtherance of your license and use of software made available to your company from Infor pursuant to a separate agreement ("Purpose").

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to maintain such material in strict confidence and that your use of such material is limited to the Purpose described above.

Although Infor has taken due care to ensure that the material included in this publication is accurate and complete, Infor cannot warrant that the information contained in this publication is complete, does not contain typographical or other errors, or will meet your specific requirements. As such, Infor does not assume and hereby disclaims all liability, consequential or otherwise, for any loss or damage to any person or entity which is caused by or relates to errors or omissions in this publication (including any supplementary information), whether such errors or omissions result from negligence, accident or any other cause.

Publication Information

Release: SyteLine version 8.01
Publication Date: November 2009
Contents

Multi-Site Checklist ................................................................. 7

Planning ................................................................. 11

Setting Up the Database Server ................................................. 13
  Install Infor ERP SyteLine and Create a Site Database ................. 13
  Create Additional Site and Entity Databases ............................... 14
  Link Databases ................................................................. 16
    About Linking Databases .................................................. 19

Setting Up the Utility Server .................................................. 21
  Install SyteLine and Configure Components .............................. 21
  Create Additional Client Configurations ................................ 22
  Add Web Servers Used by the Configurations ............................. 26
  Define Configuration Groups ................................................. 28
  Update Service Configuration Manager Settings ......................... 29
    Set Up Monitoring of Events for Various Configurations ............ 30
    Set Up TaskMan Monitoring of Configurations .......................... 30
    Set Up Replication and On-Ramp Options ................................ 31
  Stop and Restart Infor Services ........................................... 33
  Use One Console to Administer All Sites/Entities ...................... 34

Setting Up End User Clients .................................................. 35
  First Time Login ............................................................. 35
  Specifying a Configuration Group for a Client ......................... 36
  Specifying Other Startup Parameters for a WinStudio Client .......... 36

Setting Up Replication at Sites and Entities ............................... 37
  Setting Up Transactional Replication .................................... 38
    Define Intranets ............................................................. 38
    Define Linking Between Sites and/or Entities ......................... 39
    Set Up Replication Categories and Rules ................................ 41
    Populate Parameter _All Records at Other Sites ....................... 43
  Setting Up a Master Site and Shared _All Tables ......................... 44
    Set Up All Sites on the Intranet ....................................... 44
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Up the Master Site</td>
<td>44</td>
</tr>
<tr>
<td>Set Up Shared _All Tables</td>
<td>46</td>
</tr>
<tr>
<td>Set up Replication to Sites in Other Intranets</td>
<td>47</td>
</tr>
<tr>
<td>Setting Up Non-Transactional Replication</td>
<td>48</td>
</tr>
<tr>
<td>Set Up a Replication User</td>
<td>48</td>
</tr>
<tr>
<td>Set Up System Types</td>
<td>49</td>
</tr>
<tr>
<td>Define Intranets</td>
<td>50</td>
</tr>
<tr>
<td>Define Linking Between Sites and/or Entities</td>
<td>53</td>
</tr>
<tr>
<td>Set Up Replication Categories and Rules</td>
<td>56</td>
</tr>
<tr>
<td>Populate Parameter _All Records at Other Sites</td>
<td>57</td>
</tr>
<tr>
<td>Setting Up Licensing at Sites and Entities</td>
<td>59</td>
</tr>
<tr>
<td>Intranet Licensing</td>
<td>59</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>59</td>
</tr>
<tr>
<td>Turn on Intranet Licensing at the Master Site</td>
<td>59</td>
</tr>
<tr>
<td>Turn on Intranet Licensing at Other Sites</td>
<td>60</td>
</tr>
<tr>
<td>Site/Entity Licensing</td>
<td>61</td>
</tr>
<tr>
<td>Setting Up Accounts and Financial Reporting Hierarchies</td>
<td>63</td>
</tr>
<tr>
<td>Set Up the Financial Reporting Hierarchy</td>
<td>63</td>
</tr>
<tr>
<td>Set Up Accounts</td>
<td>65</td>
</tr>
<tr>
<td>Set Up Financial Statements</td>
<td>71</td>
</tr>
<tr>
<td>Setting Up Parameters and Codes</td>
<td>73</td>
</tr>
<tr>
<td>Set Up Site Groups</td>
<td>73</td>
</tr>
<tr>
<td>Set Up Countries and States</td>
<td>74</td>
</tr>
<tr>
<td>Set Up Currency</td>
<td>75</td>
</tr>
<tr>
<td>Set General Parameters</td>
<td>77</td>
</tr>
<tr>
<td>Set Up Bank Codes</td>
<td>79</td>
</tr>
<tr>
<td>Set System Parameters</td>
<td>80</td>
</tr>
<tr>
<td>Setting Up Users and Authorizations</td>
<td>87</td>
</tr>
<tr>
<td>Update the &quot;sa&quot; User</td>
<td>87</td>
</tr>
<tr>
<td>About the SL_Internal User</td>
<td>88</td>
</tr>
<tr>
<td>Set Up Password Parameters</td>
<td>88</td>
</tr>
<tr>
<td>Add Common Users</td>
<td>89</td>
</tr>
<tr>
<td>Copy Users</td>
<td>91</td>
</tr>
<tr>
<td>Adding External Users</td>
<td>91</td>
</tr>
</tbody>
</table>
Multi-Site Checklist

Follow this checklist when implementing a new multi-site system. Each step has a corresponding chapter that describes the step in detail.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Where</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Plan:</strong>&lt;br&gt;See the Multi-Site Planning Guide - Create spreadsheets and flowcharts&lt;br&gt;Decide whether transactional/non-transactional replication will be used</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td><strong>Set up Database Server:</strong>&lt;br&gt;Install Infor ERP SyteLine and create one site database&lt;br&gt;Create additional application databases for sites/entities - Infor ERP SyteLine Configuration Wizard&lt;br&gt;Link application databases - Infor ERP SyteLine Configuration Wizard (transactional only)</td>
<td>Database server</td>
</tr>
<tr>
<td>3</td>
<td><strong>Set up Utility Server:</strong>&lt;br&gt;Install and configure Infor ERP SyteLine.&lt;br&gt;Create additional client configurations for other sites/entities - Infor ERP SyteLine Configuration Wizard&lt;br&gt;Add web servers used by the configurations&lt;br&gt;Define configuration groups&lt;br&gt;Update Service Configuration Manager utility settings to:&lt;br&gt;Set up monitoring of configurations for events&lt;br&gt;Set up monitoring of configurations by TaskMan&lt;br&gt;Set up a replication configuration (non-transactional only)&lt;br&gt;Restart the services&lt;br&gt;Use one console to administer all sites/entities</td>
<td>Utility server</td>
</tr>
<tr>
<td>4</td>
<td><strong>Set up end user clients.</strong></td>
<td>Utility server or client machines</td>
</tr>
<tr>
<td>5A</td>
<td><strong>Set up transactional replication:</strong>&lt;br&gt;Set up replication links - Intranets form, Sites/Entities form&lt;br&gt;Set up replication categories and rules - Replication Categories form, Replication Rules form, Replication Management form&lt;br&gt;Populate parameter _all records at other sites</td>
<td>Sites and Entities</td>
</tr>
<tr>
<td>5B</td>
<td><strong>Set up master site and shared _all tables:</strong>&lt;br&gt;Set up transactional replication (above)&lt;br&gt;Set up the master site - Intranets form, Sites/Entities form, Intranet Shared Tables form</td>
<td>Sites and Entities</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
<td>Where</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>5C</td>
<td>Set up non-transactional replication:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Create replication user - Users form, User Modules form (requires license)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set up system types - System Types form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set up replication links - Intranets form, Sites/Entities form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set up replication categories and rules - Replication Categories form,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Replication Rules form, Replication Management form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Populate parameter _all records at other sites</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sites and Entities</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Set up licensing:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- If using intranet licensing, turn it on at the master site and any participating</td>
<td></td>
</tr>
<tr>
<td></td>
<td>sites (not entities) - Sites/Entities form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- License Management form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sites and Entities</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Set up financial reporting hierarchy:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Change Reports To Entity form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sites and Lower-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>level Entities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set up accounts:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Chart of Accounts form - add all accounts; add CTA account</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Multi-Site Chart Copy form - copy COA to mid-level entities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unit Code 1-4 forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Copy Unit Codes to Accounts form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Accounting Periods form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set up financial statements - Financial Statement Definition, Financial</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Statement Definition Columns, and Financial Statement Line Definition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Top-level Entity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set up accounts:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Chart of Accounts form - specify Reports To account information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unit Code 1-4 forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Copy Unit Codes to Accounts form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Accounting Periods form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Verify Accounts To Report form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set up financial statements (only if mid-level entities will run them)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mid-level Entities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set up accounts:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Chart of Accounts form - delete accounts that don’t apply</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unit Code 1-4 forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Copy Unit Codes to Accounts form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Accounting Periods form - just specify current period</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set up financial statements (only if sites will run them)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sites</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
<td>Where</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| 8    | Set up parameters and codes needed for later steps:  
|      | - Set up Site Groups - Site Groups form  
|      | - Set up Countries and States - Countries form, Prov/States form  
|      | - Set up Currency - Multi-Currency Parameters form, Currency Codes form, Currency Rates form  
|      | - General Parameters form  
|      | Set up bank codes:  
|      | - Bank Reconciliations form  
|      | Set up system parameters:  
|      | - Inter-Site Parameters form  
|      | - Accounts Receivable Parameters form  
|      | - Accounts Payable Parameters form  
|      | - Order Entry Parameters form  
|      | - Purchasing Parameters form  
|      | - Transfer Order Parameters form  
|      | - Planning Parameters form  
|      | - Other parameter forms as needed  
|      | Sites and Entities (some information will replicate)  
| 9    | Set up users and authorizations:  
|      | - Add "Enter Out of Date Range" group for "sa" user - Users form  
|      | - Set up parameters for passwords - Password Parameters form  
|      | - Set up other users - Users form, Object Authorizations for Users form, User Modules form (if using intranet licensing, run User Modules only at master site)  
|      | - Set up any external customers or suppliers who will log in remotely via the internet as users on particular sites.  
|      | Sites and Entities  
| 10   | Set up supporting data:  
|      | - See the list of forms in this step. The forms you use depend on your company’s requirements.  
|      | Sites  
| 11   | Set up operational data:  
|      | - Add common customers - Customers form  
|      | - Add common vendors - Vendors form or Multi-Site Vendors form  
|      | - Add common items - Items form, Global Items form  
|      | - Set up employees - Employees form  
|      | - Set up other operational data - see list of forms in this step. The forms you use depend on your company’s requirements.  
|      | Sites  
| 12   | Set up add-on products and modules  
|      | Depends on the product  |
Follow these steps to plan your multi-site implementation:

1. See the *Multi-Site Planning Guide*. When you complete the steps in that guide, you will have spreadsheets and flowcharts containing most of the information you need to install and configure your sites. You can then update the spreadsheets to track changes as your system grows.

2. You must know which type of replication you are using before you set up your system, because some steps apply only to one type or the other:
   - **Non-transactional** replication, as used in this guide, refers to any inbound or outbound asynchronous replication. This can include applications that integrate with SyteLine by posting data via XML documents into the SyteLine sites, as well as SyteLine sites using XML to communicate with each other. Infor SyteLine Enterprise Financials, and EAM would fall into this category.
   - **Transactional** replication, as used here, means that sites and entities are on the same database server and are replicating records through database triggers and stored procedures as soon as the records are added or changed on one site. The use of master sites and intranet shared tables requires much of the same setup as transactional replication.

3. Strongly consider setting up a test environment and making sure everything works properly before setting up your production environment. See Appendix B, “Setting Up a Test Environment,” for more information.
Install Infor ERP SyteLine and Create a Site Database

On each SQL server machine where you will be adding site or entity databases, follow the steps in the *Infor ERP SyteLine Installation Guide* chapter "Setting Up the Database Server" to install the application and do the following:

- Create one **initialized application database**.
- Use your **SiteEntity spreadsheet** (from the Planning phase) to enter the site information when configuring the database.
- Create at least one **forms database** for your system. Your SiteEntity planning spreadsheet should indicate how many forms databases you need and what to name each one. Later, on the utility server, you will specify which forms databases are used with which application databases.
- Create at least one **objects database** for your system. The SiteEntity planning spreadsheet should contain the information you need for this. Later, on the utility server, you will specify which objects databases to use with application databases.

After creating **one** application database, **one** forms database, and **one** objects database, return to this chapter to perform the following additional steps.
Create Additional Site and Entity Databases

To add multiple site and/or entity databases on each database server:

1. Run the **Infor ERP SL Configuration Wizard** again.
2. Select **Create SyteLine Databases** and click **Next**.

3. You can add all of the site and entity application databases in one session. Just click the **Add** button again after defining each database.

   a. When prompted for the database type, select **Initialized Application Database**
      This is true for either site or entity databases. (The only time you would choose Empty Application Database instead is if you are migrating from a Progress database.)
b. On the **Database Name and Location** screen and the **Set Database Site Parameters** screen, enter the application database information from your **SiteEntity** planning spreadsheet. The SQL Data File Path and Log File Path are generally just defaulted in for application databases. The SQL User defaults to the "sa" user.

c. Click **Next** to return to the Summary screen with the new database listed.

4. Click **Next** to review and then **Commit** the configuration changes. If you are creating several databases, this step may take some time to complete.

5. Click **Finish** to close the wizard.
Link Databases

NOTE: Perform the steps in this section only if you plan to use transactional replication to replicate data to or from site/entity databases located on this database server.

After you have defined all your databases, link them so they can communicate with each other. Follow these steps:

1. Run the Infor ERP SL Configuration Wizard again.
2. Select Link Databases for Multi-Site Use and click Next.
3. When you first enter the Link Multi-Site Databases screen, there are no databases listed. Specify a Group Name for the set of databases on this machine that you want to link together. Use the group name from your SiteEntity spreadsheet.
Every time you run the Configuration Wizard, the first time you display this screen, the list of databases will be blank - even if linked databases already exist in the group you specify. To add a new database to an existing group, you must re-add all of the databases here. This sets up each database for multi-site use and links it to all of the other databases that are added at the same time.

TIP: Later, in the application’s Site Groups form, you can add more groups or change the groups to which a site or entity belongs.

4. For each site or entity database that you want to be linked, click Add and specify the connection information for the database:

- **SQL Server Name** - Name of the SQL Server where the site/entity application database you want to link to resides.
- **SQL Username and Password** - Name and password of a SQL user who can access and update this database. Usually this is set up as the **sa** user.
- **Application Database to Link** - Enter or select the name of one of the site or entity application databases to be linked. (You will be adding the others in the next step.)
- **Site ID** - The site ID of the database you specified displays.
- **Site Description** - the description of the the database you specified displays.
5. Click **Next** to return to the previous screen and add another database to be linked.

TIP: Make sure you link only *application* databases (not forms or objects databases).

6. When all of the site and entity application databases you want to link are listed, click **Next**.

7. Review the changes and click **Commit**.

8. Click **Finish** to close the wizard.

TIP: Each time you run the Configuration Wizard on either the database server or the utility server, it appends information about the configuration changes to a log file found on that server under

   Infor\SyteLine\Tools\SLConWiz.log.
9. If you plan to perform **transactional replication between sites on this database server and other sites that are not on this database server**, create a linked server definition in the SQL server master database of both the current site and the To site. Do this with the SQL Server Management Console: in the console tree, open the Server Objects folder for the server and right-click on the Linked Servers node.

This should match the list of linked servers you added in the Configuration Wizard.

**NOTE**: If all sites are on one database server, or if you are not using transactional replication, you can skip this step.

**About Linking Databases**

- Whenever you add a new site to an existing transactional multi-site environment, you must relink all sites using the Configuration Wizard. If you create and configure the new site by itself, it will prepare that database for multi-site work, but it will not know about other existing databases.
- Although the databases do not all have to be on the local server, transactional replication is much more efficient when they reside on the same server.
- You can run the wizard again to add more links later if needed.
- When you link multi-site databases with the Configuration Wizard, the following things are altered in the databases:
  - site table - new entries are added or updated.
  - * _all tables - row pointers are altered, foreign keys are temporarily dropped, tables are truncated and repopulated, and foreign keys are reapplied.
  - ApsResyncAllSp runs against each database.
  - site_group table - new entries are added or updated.
  - site_live_link table - new entries are added or updated.
- If you plan to use **transactional replication** between all the sites and entities in each reporting hierarchy or intranet, but also use **non-transactional replication** between sites in different reporting hierarchies or intranets, you should create a group for each reporting hierarchy and link together the sites/entities in each group. So you would run the wizard multiple times to create multiple linked groups.
Setting Up the Utility Server

Install SyteLine and Configure Components

On each utility server machine where you will be creating configurations, follow all the steps in the *Infor ERP SyteLine Installation Guide* chapter "Setting Up the Utility Server." These steps will:

- Install the application.
- Create an initial configuration on the utility server that links to one site database, using one of the configuration names you specified during your Planning phase.
- Set up a Web server (IIS-based) on the utility server. This is used by the online help, non-transactional replication, and integration with some applications.
- Set up the TaskMan service for the utility server.
- Set up replication services on the utility server.

**NOTE:** Replication services are needed only if any of the configurations to be defined on this utility server will be running non-transactional replication.

- Set up a Planning and Scheduling gateway and server (used only with APS).
- Set up Crystal Reports so that you can print and preview reports.
- Through the Service Configuration Manager, set up monitoring of that first configuration by the TaskMan, replication, and event services.
- Set up an administrative client on the utility server that points to a specified URL. This URL is the utility/web server where the various configurations will be defined.

Then return to this chapter for the following additional steps to create configurations for the rest of your sites and entities.
Create Additional Client Configurations

You must add a client configuration for each site and entity database you want to access through this utility/web server.

**CAUTION:** If you have multiple utility/web servers, only one of them should be designated as the Configuration Server, and the Configuration Manager utility should be run only on that Configuration Server. The resulting MongooseConfigs.xml file should then be copied to the other utility/web servers so they have access to the defined configurations. See the *Multi-Site Planning Guide* for information about the Configuration Server.

For each site and entity, you must create one configuration name that exactly matches the site ID and that uses the site’s application database. (You can create additional configurations for the site or entity, with different names.)

1. On the utility/web server, select **All Programs>Infor>Tools>Configuration Manager** from the Start menu. The Configuration Manager should display the initial configuration that was created during installation and setup of the utility/web server.
2. Click **New** to create a new configuration.

3. Enter the new configuration name and click **OK**.

4. In the Runtime (Client) tab, define the application and forms database connection information for the new configuration:

TIP: Use the information from your **SiteEntity and Configurations planning spreadsheets** to help you fill in access information (SQL server name, login, password, and database name) for the application, forms, and objects databases.
5. In the Objects Metadata tab, click **Set Objects DB Specification** and then specify the Objects database name.

6. Click **OK**. A confirmation message displays; click **OK** again.

7. If using FormControl or SourceSafe, set up information on those tabs as needed.

8. Click the **OK** button at the bottom of the Edit Configuration screen to save the configuration and return to the Configurations tab, where the new configuration displays:

9. Repeat steps 2 - 8 until all configurations are defined.
TIP: If a new configuration definition will be very similar to an existing one (for example, if just the application database name is different), you may want to use Copy instead of New. This creates a copy with a new configuration name and you then select Edit to modify the definition.

You must manually specify the Objects database in each copied configuration.
Add Web Servers Used by the Configurations

If you have multiple web/utility servers through which your clients can access the configurations, define them in the Web Servers tab of the Configuration Manager. They will be accessed in round-robin order as session requests come in to the Configuration Server. (See the **CAUTION** on page 22 about running the Configuration Manager utility only on the Configuration Server.)

1. Click **New**.

2. Enter a logical name for the web/utility server, and click **OK**.

3. Enter the http address of the web/utility server and click **OK**.
4. The server is added to the list of web servers the configurations can access.
Define Configuration Groups

You should have determined during the Planning phase whether you will have multiple configuration groups. If so, select the **Configuration Groups** tab in the Configuration Manager utility.

![Configuration Manager](image)

Click the **New** or **Edit** buttons to display a dialog where you can define new groups and add configurations to them. The configurations must already be defined on the Configurations tab.

![Edit Configuration Group](image)

Configuration group names can contain only alphanumeric characters and the underscore character.

The Default group is predefined and cannot be deleted (but it can be edited). This group initially contains every configuration. If there are no configuration groups defined in your current configuration file (MongooseConfigs.xml), you will still see the Default group containing all configurations. Whenever you create a new configuration, it is added to the Default configuration group. If clients request configurations and do not specify a configuration group (or specifies "Default"), they will be presented with only configurations in the Default group.
Update Service Configuration Manager Settings

When you add configurations, you need to update the Service Configuration Manager utility so that the new configurations will be monitored by Infor services such as TaskMan, Replication, and the Event System.

To access this utility, select **All Programs** > **Infor** > **Tools** > **Service Configuration Manager** from the Start menu on the utility server.

![Service Configuration Manager](image)

The General tab shows what services are installed on this utility server and where to find configuration files. You can also specify a default configuration here, but currently it only applies to the Replication services.
Set Up Monitoring of Events for Various Configurations

Use the Event Service tab on the Service Configuration Manager to specify each of the configurations you want the Event System to monitor.

See the *Multi-Site Planning Guide* for information about monitoring configurations for events. You may have created an Events spreadsheet as part of your planning process.

1. On the Events tab, click **Add** to display a dialog box where you can select a configuration and optionally specify sleep time (defaults to 10 seconds) and the maximum number of concurrent events that can run in this configuration (defaults to 5). For more information, see the Service Configuration Manager online help.

2. Repeat Step 1 for all configurations you want the Event System to monitor. Usually you will select all configurations for monitoring.

3. Click the **Save** button at the bottom of the window to save your changes. The system will not recognize the changes until you stop and restart the services later in this chapter.

Set Up TaskMan Monitoring of Configurations

Set up TaskMan to monitor configurations for any application database on which users will be executing reports, stored procedures, IDO methods, executables, or other background tasks. Include entity application databases, since financial reports can be run on them.

See the information on TaskMan monitoring of sites in the *Multi-Site Planning Guide*.

1. Go to the TaskMan tab of the Service Configuration Monitor.
2. Click **Add** to display a dialog box where you can select a configuration and optionally a DSN. (DSNs are only needed for some custom reports created in previous versions. See the Service Configuration Manager online help for more information.)

3. Click **OK**. The configuration is added to the list in the TaskMan tab.

4. Repeat Steps 2 and 3 until you have added all the configurations you want TaskMan to monitor.

5. Click the **Save** button at the bottom of the window to save your changes. The system will not recognize the changes until you stop and restart the services later in this chapter.

### Set Up Replication and On-Ramp Options

On the Replication tab, configure the options used in non-transactional replication and in BOD (On-Ramp) replication.

Refer to the online help for this tab of the Service Configuration Manager for details on how to set up these fields. Be aware of the following:
If any of the configurations defined on this utility server will be running *non-transactional* replication (see the definition on page 11), specify the replication configuration. The configuration name must exactly match the site ID.

The Replicator service uses this site to bootstrap itself. From this site, the Replicator can query a list of all the other sites on its intranet, and connect to those to monitor them as well. Choose a site at which the site and intranet definitions are completely up to date.

Each site configuration on this utility server that will be replicating data non-transactionally must have a configuration name that *exactly matches* its site name. This allows the Replicator to connect to the other sites by mapping the site name to the configuration name when it logs in.

If you set up a default configuration on the General tab, the system uses that configuration as the replication configuration if you don’t enter one here.

In a multi-site environment, one site per intranet collects in its replication document outbox all outbound business object documents (BODs) generated by sites on that intranet. That site is designated through the (*Replicator*) **Configuration** field in the Service Configuration Manager utility.

In a multi-site environment, you designate one configuration whose application database is the entry point for BODs sent by the Infor On-Ramp for all sites on the intranet. (That is, the replication document inbox on the site is expected to receive inbound BODs for all sites on its intranet.) The Infor Framework Inbound Bus Service uses this site’s replication document rules and site definitions for processing all incoming BODs. This site is designated through the **Inbound Bus Configuration** field in the Service Configuration Manager utility.

Click the *Save* button at the bottom of the window to save your changes. The system will not recognize the changes until you stop and restart the services later in this chapter.
Stop and Restart Infor Services

On the utility server, stop and restart the services so that they will be aware of any updates made in the Configuration Manager and Service Configuration Manager.

1. Select **Administrative Tools**>**Services**.

2. Right-click on the **Infor Framework IDO Service** and select **Stop**. A message displays to tell you that stopping this service will also stop other dependent Framework services.

3. Click **OK**.

4. When the services are stopped, restart them again, starting the **Infor Framework IDO Service** first.

**TIP:** It may be simpler to just restart the utility server machine. This automatically stops and starts all the services.
### About the Services

<table>
<thead>
<tr>
<th>Service Name</th>
<th>When to Stop/Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infor Framework Event Service</td>
<td>When you add, edit or delete configurations, or change which configurations are monitored, you must stop and restart these services so they recognize the changes. If you change the following information for a site, you must restart the TaskMan service:</td>
</tr>
<tr>
<td>Infor Framework Replication Queue Listener</td>
<td>* Forms Database Name</td>
</tr>
<tr>
<td>Infor Framework Replicator</td>
<td>* Intranet Name</td>
</tr>
<tr>
<td>Infor Framework TaskMan</td>
<td>* Polling Interval</td>
</tr>
<tr>
<td></td>
<td>* Maximum Concurrent Tasks</td>
</tr>
<tr>
<td></td>
<td>* Maximum Concurrent Report Tasks</td>
</tr>
<tr>
<td></td>
<td>* Report URL</td>
</tr>
<tr>
<td></td>
<td>* TaskMan Path</td>
</tr>
<tr>
<td></td>
<td>If you change the Intranet Name for a site, or change other non-descriptive information about the site or intranet, you must restart the replication services.</td>
</tr>
<tr>
<td>Infor Framework IDO Runtime Service</td>
<td>Stopping the IDO Runtime Service also stops all dependent services (Event, Inbound Bus, Replication Queue Listener, Replicator, and TaskMan). When restarting the services manually, start the IDO Runtime Service first.</td>
</tr>
<tr>
<td></td>
<td>When you edit or delete configurations, or change which configurations are monitored, you must stop and restart this service so it recognizes the changes.</td>
</tr>
<tr>
<td></td>
<td>When you add configurations, you can either:</td>
</tr>
<tr>
<td></td>
<td>* Stop and restart this service, or</td>
</tr>
<tr>
<td></td>
<td>* Discard the cache. On the Configuration Manager’s Utilities tab, click Discard Cache. This refreshes the list of configuration to pick up any new configurations created since the IDO Runtime Service was started.</td>
</tr>
<tr>
<td>Infor Framework Inbound Bus Service</td>
<td>If you change the configuration used by Infor On-Ramp on the Replication tab of the Service Configuration Manager, you must stop and restart the service.</td>
</tr>
<tr>
<td>Infor Framework Fax Service</td>
<td>This service, which monitors certain folders and picks up fax control files at specified polling intervals, is not affected by configuration changes.</td>
</tr>
<tr>
<td>Infor Validator Service</td>
<td>This service, which validates the user/domain and password, is not affected by configuration changes.</td>
</tr>
</tbody>
</table>

### Use One Console to Administer All Sites/Entities

You should be able to log in to client configurations for each site and entity from a single console. This will simplify the setup and administration of your multi-site system.

If some of your sites/entities are on a remote utility server, set up a remote client configuration as described in the *Infor ERP SyteLine Installation Guide* chapter on setting up clients.
Install and configure end user clients as described in the Infor ERP SyteLine Installation Guide chapter on setting up a client workstation.

STOP before you perform the steps in the "Run SyteLine" section of that chapter and return to this guide. Multi-site setup has some different steps - and many additional steps - as described in the following chapters.

Users of each site and entity need access to an end user client configuration for that site or entity.

First Time Login

1. Using the administrative client on each utility server, start SyteLine. Use the shortcut on the desktop, or use the Windows menu to navigate to Infor>SL 8.0 Client.
2. Select the configuration for that site or entity, and log in as sa. Enter the SQL password for the sa user. This is the default password for the SyteLine sa user; you can change it later in the application.

   TIP: If you will be administering several site configurations from a single console, you may want to display the site configuration name in the window's title bar. This helps you keep track of which site you are currently working in. To set this up, select View>Settings from the SyteLine toolbar. In the Settings dialog, select Show Configuration Name on Caption.
Specifying a Configuration Group for a Client

When users start SyteLine, they are presented with a list of configuration names to select from. If you set up configuration groups through the Configuration Manager utility, then you can specify a group name as part of the client connection information:

- If a client is using a WinStudio shortcut, you can specify the configuration group name using the `-g config-group` command line option. For example:
  ```
  WinStudio.exe -g Acme
  ```

- If a client is connecting to the Configuration Server using HTTP, the configuration group may be specified as a query parameter in the URL. For example:
  ```
  ```

- If you are using XML to connect, you can specify the configuration group name as part of the GetConfigurations IDO request. For example:
  ```
  <IDORequest>
  <RequestHeader Type="GetConfigurations" ConfigGroup="Acme"/>
  </IDORequest>
  ```

Specifying Other Startup Parameters for a WinStudio Client

If a client is connecting using a WinStudio shortcut, you can specify additional startup parameters as described in the "About WinStudio Startup Parameters" help topic (found via Help>Customizing Forms).
During the Planning phase, you should have determined which type of data sharing you will use, and which categories of data will be replicated or shared. For detailed information about how replication works, see the *Replication Reference Guide*.

This section describes the steps to set up each of these types of data sharing between sites and entities.

<table>
<thead>
<tr>
<th>Type of replication</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactional replication</td>
<td>38</td>
</tr>
<tr>
<td>Master site and shared _All tables</td>
<td>44</td>
</tr>
<tr>
<td>Non-transactional replication</td>
<td>48</td>
</tr>
</tbody>
</table>
Setting Up Transactional Replication

NOTE: Skip this section if you are not using transactional replication (see the definition on page 11).

Log into each site and entity as "sa" and perform the following steps. See the online help on the various forms for more information about any step.

Define Intranets

1. In the Intranets form, specify all intranets to be used in this multi-site system. The default intranet is DEMO. You may need additional intranets. During the Planning phase you should have determined the intranets you need and which sites will use them.

   ![Intranets form](image)

2. If you will be sharing all tables and using a master site, define an intranet that will include all the sites that share tables. This cannot be an "External" intranet. All the sites on this intranet must use the same version of SyteLine.

   TIP: We recommend that you specify a new intranet - not the default DEMO intranet - for this purpose.

   Do not define the master site for the intranet yet - that will be done later.
3. In the **TaskMan Path** field for each intranet, specify the shared path to the TaskMan folder on the utility server used by that intranet (usually `\machinename\SyteLine`). For more information about how this field is used, see the *Multi-Site Planning Guide* information on TaskMan monitoring.

Any time you change the TaskMan Path, you should restart all TaskMan services that monitor configurations for application databases connected to this intranet.

4. If you want users to preview report output over the internet, use the **Report URL** field to specify the base URL path to the report output files. You will also need to create an IIS virtual directory that maps to this Report URL.

### Define Linking Between Sites and/or Entities

Use the **Sites/Entities** form to specify information about this site/entity and the other entities and sites that it communicates with:

1. On the **Sites/Entities** form, ensure that each site/entity that was linked to the current site (see “Link Databases” on page 16) has a record in this form. This should happen automatically.

2. On the System Info tab, select the record for each site:
   a. Make sure the **Time Zone**, **Database Name**, and **Forms Database Name** are set correctly.
   b. Set the **Intranet Name** to one of the intranets you defined on page 38.

**NOTE:** The Reports To (entity) field on this tab is display-only. Reporting hierarchies are set up later through the Change Reports to Entity utility (page 63).

3. Review the list of linked sites shown in the **Link Info** tab. If you used the Infor ERP SL Configuration Wizard on the database server to set up linked sites (page 16), this tab shows those links, which are used in transactional replication between the currently selected site record’s database and other site/entity databases.
The local site’s record should show all the other databases linked to this site:

The records for other sites/entities should show the link to the local site:

The Linked Server Name is the name of the database server where the site database resides.

On the local site’s record, you can add any other needed links between this local site/entity and other site/entity databases that will perform transactional replication with this database. This information will be replicated to other sites through the Site Admin replication category.
Set Up Replication Categories and Rules

1. Familiarize yourself with the default categories listed in the Replication Categories form. Be aware of what categories are available and what each one handles. See the Multi-Site Planning Guide for additional information about the categories.

2. Use the default categories "as is" for now. You may want to add to or modify the categories later when your system is up and running.

3. In the Replication Rules form, set up rules for the Site Admin category from this site to all other sites and entities where replication will take place.

   Add more rules from this site/entity to other sites/entities, as appropriate.

   - For the Interval Type, select Transactional.
You should have created a ReplicationRules spreadsheet as part of your Planning phase. You can save time by importing the appropriate rules for each site from the spreadsheet into the grid on the form at that site/entity. See Appendix C, “Data Load To/From Spreadsheets,” for more information.

If a rule refers to a site/entity that is not set up with matching information in the Sites/Entities form, the system will give a validation error when you try to save it.

Even if a category contains _all tables that you plan to share, you generally still want to include replication rules for the category. The shared _all tables in the category will not be replicated; however, many categories contain additional base tables or stored procedures that are needed to perform certain functions. (See the example on page 47.)

4. Go to the Replication Management form and click Regenerate Replication Triggers.

NOTE: Finish this step for all sites and entities before continuing with the next step.
Populate Parameter _All Records at Other Sites

1. In the Update _All Tables form at each site and entity, repopulate the parameters _all tables.

   ![Update _All Tables form]

   TIP: In an initialized database, the parameters tables already have one record defined for the local site. Because the record already exists, it will not be created at other sites through normal replication. Repopulating the tables ensures that a parameter record for the local site exists at other sites where it is needed.

   a. Click Deselect All to deselect all tables in the form.
   b. Select the check boxes for the following parameters tables:
      - apparms_all
      - arparms_all
      - coparms_all
      - curracct_all
      - currency_all
      - currparms_all
      - dcparm_all
      - euro_parms_all
      - invparms_all
      - mrp_parm_all
      - parms_all
      - poparms_all
      - taxparms_all
   c. Make sure nothing else is selected (including Disable Replication or a Site name).
   d. Click Repopulate Tables to repopulate each selected parameters _all table at the local site and to create or repopulate the local site record at any other sites/entities to which the local site is replicating a category containing the parameter table.

   TIP: At this point, it may be wise to back up all of your databases, so you do not have to re-add all of your replication setup if problems occur later in the implementation.
Setting Up a Master Site and Shared _All Tables

NOTE: Skip this section if you are not using a master site or intranet shared tables.
See the online help on the various forms for more information about any step.

Set Up All Sites on the Intranet

At all sites and entities on the intranet where sharing will take place (including the master site), perform all the steps under “Setting Up Transactional Replication” on page 38 through 43.
Then return to this page for additional instructions.

Set Up the Master Site

Log in to the site that you want to make the master site where the shared tables will exist for the intranet. Then follow these steps at that site only:

NOTE: We recommend that you use a site database, not an entity, as your master site.

1. Verify the information on the Link Info tab on the Sites/Entities form at the master site:
   a. On the Link Info tab for the master site’s record, each of the other sites on its intranet should be listed as linked sites. For example, if the master site is ILL and the other sites on the intranet are CRP, USA, and CAL, the local site record for ILL would list all the other sites on its intranet:

   ![Sites/Entities screenshot](image)
b. On the Link Info tab for other site records on the shared intranet, the master site should be listed. For example, when you are logged into the ILL master site, the CAL site record’s Link Info tab would look like this:

Sites on other intranets do not require Live Link information at the master site.

2. On the Intranets form, select this site’s intranet. In the Master Site field, specify the master site where shared tables will reside.

The following must be true in order to add or change a value in this field:

- You must be logged into the site that you want to specify as the master site.
- This site must be defined as being within the selected intranet. Live links must be set up (on the Sites/Entities form) between this site and the other sites in the intranet.
- No table within the intranet is currently shared.
- This master site must be a SyteLine site, not an entity.

TIP: After you define the master site for an intranet on the master site’s Intranets form, the master site name displays, but cannot be changed, on the Intranets form at all other sites. (This assumes you have set up replication of the Site Admin category from the master site to the other sites in the intranet.)
Set Up Shared _All Tables

1. On the Intranet Shared Tables form at the master site, select this site's intranet. A list of the _all tables that can be shared displays. (Not every _all table is listed; some are not available for sharing.)

   ![Intranet Shared Tables Form]

   a. For tables that you want to be shared between all sites on the intranet, select Shared.
   
   Another way to choose the shared tables is to select the replication categories that you want to share. When you select a Replication Category from the drop-down list and click Select by Category, the system marks _all tables in that category as Shared.

   b. When you have selected all the tables you want to share, select Actions>Save.

   c. Click Process. This copies information from the tables at the other sites to the master site's table, deletes the table from the other sites (creating views into the master site tables instead), and regenerates the replication triggers for the other sites. If you have selected several tables and have many sites on this intranet, processing may take a while. The Processing Step area displays the system's progress.

   **CAUTION:** During processing, the selected tables are removed from all sites on the intranet except the master site. Unsharing (rebuilding the tables at the using sites) is time-consuming - so be very sure that you have everything set the way you want it before clicking the Process button.

During processing, the system validates live link setup between the master site and the using sites of an intranet. If it finds a problem, an error message displays and nothing is processed; fix the link and then click Process again.
The Processed field indicates which tables have been processed - for example, if shared, they are now resident only in the master site's database. (Once a row on the form is marked as Processed, subsequent "Process" runs will not reprocess that row.)

After processing all the tables and sites, the system regenerates the replication triggers at the master site.

Set up Replication to Sites in Other Intranets

If there are other intranets with sites that want to replicate (not share) _all table data to/from sites in the sharing intranet:

- For tables that are shared, set up replication categories/rules between the master site and the sites on the other intranets. (You probably will also need to set up the same categories/rules between the specific shared site and the sites on other intranets; see the example below.)
- For tables that are not shared, set up replication categories/rules between any/all of the sites in the shared intranet and the sites on the other intranets.

Example

In the setup shown below, the following are true:

- If CAL needs visibility into BC's item data, replication rules for a category containing item_all should be set up from BC to ILL.
- If BC needs visibility into CAL's item data, replication rules for a category containing item_all should be set up from ILL to BC.
- If BC and CAL interact in other ways, for example order entry of an item in BC and shipment of the item from CAL, you still need Centralized Order Entry replication rules between CAL and BC, since additional tables and stored procedures in that category are needed to perform these functions. The item_all table, although it exists in the category, will not be replicated from CAL to BC.
- If ONT needs visibility into CAL's customer data (which is not a shared table), replication rules for a category containing customer_all should be set up from CAL to ONT.
Setting Up Non-Transactional Replication

Skip this section if you are not using non-transactional replication (see the definition on page 11).

If you are using non-transactional replication only to interface to another Infor product refer to the setup steps in the appropriate product’s implementation guide, instead of the steps below.

Log into each site and entity as "sa" and perform the following steps. See the online help on the various forms for more information about any step.

Set Up a Replication User

NOTE: Before completing this step, you will need to install a license. See Chapter 6, “Setting Up Licensing at Sites and Entities,” for instructions.

Create a user account that will be used during replication between the sites/entities. Assign this user the appropriate permissions to allow replication data to complete the transaction. This protects the local site from another site inappropriately adding or modifying data on the local site without permission.

1. Add a replication user called repl_user on the Users form at all sites/entities where non-transactional replication will be used. Initially, make that user a super user and do not assign any authorization groups. It doesn’t matter what multi-site group you assign this user to.

If you have multiple administrators for different sites/entities, you may later decide to revise the permissions and groups assigned to this replication user, in order to limit the data certain sites are allowed to send to other sites. However, until everything is set up and working properly, leave this user as a super user who can access everything.
2. Click User Modules to specify the license module this user is assigned to. Generally, this should be SyteLineAutomation.

Set Up System Types

If this site will be replicating data to other applications, or to other versions of SyteLine, use the System Types form to create a system type for each other application/version. This system type is used when defining the target site for the application in the Sites/Entities form. You should also define a system type for the SyteLine application. (The source and target system types are used in the names of XSL stylesheets that can be used to transform the XML data; see the System Types help topic for more information.)

The list of system types should match at all sites. System Types are replicated by the Site Admin category rules, so create a minimum list now and add more types later as needed.

If there is not an existing system type called SyteLine, add it. Some add-on applications may require this system type.
Define Intranets

1. In the **Intranets** form, specify all intranets to be used in this multi-site system. The default intranet is DEMO. You may need additional intranets. During the Planning phase you should have determined the intranets you need and which sites will use them.

2. Specify connection information used in data requests to and from the other sites:
   - **External** - Select this field if the intranet is an external intranet, meaning that it allows applications other than those based on the SyteLine (WinStudio) toolset. Replication done on an external intranet must be non-transactional, and an external intranet cannot have a master site.
   - **Transport** - This field, which is enabled if you selected **External**, allows you to select either HTTP or ESB as the transport protocol for exchanging data with external applications.
     - **HTTP POST** is used to handle most non-transactional replication. If you select HTTP, you then define a set of MSMQ instances, MSMQ listeners, and URLs for the intranet.
     - **ESB** is used for connecting to messaging middleware through Infor On-Ramp.
   - **HTTP** - Options in this group are enabled only if you chose HTTP as the Transport method:
     - **Queue Server** - Enter the name of the MSMQ server for the intranet. If left blank, this field defaults to the utility server running this application, and the private queue area. If you have multiple intranets on different servers, include the utility server machine name in the path (for example, `machinename\PRIVATE$`).
     - **Private Queue** - We recommend that you select this field, since queues in non-transactional replication are used only by SyteLine services on the same machine. Setting up public MSMQ instances requires further Active Directory setup, which is not required by the SyteLine services.
URL - This is the web address to which the XML request/response documents will be posted. When replication occurs between sites on different intranets, XML documents are routed to this URL for the target site. It may also be used by system integrators for programmatic access to a site on this intranet.

This URL could be an ASP page on the external system that receives and processes the XML from the SyteLine message queue. The processing done at this URL is up to you; for example, an ASP page might map the data into the proper format for the external system, or it might write the XML documents to a location on its server for later processing.

In many cases, this field provides the address of the default InboundQueue ASP in the virtual directory that was installed with the web server components.

Direct IDO URL - This is the web address of the synchronous XML interface to this Intranet. It is used primarily by WinStudio clients which are configured to connect via the Internet. It may also be used by system integrators for programmatic access to a site on this intranet.

You must specify a fully qualified URL. It should be the address of the ConfigServer, which is deployed on your utility server when you include the web server feature of the utility server setup. For example, if the machine name is UTILSERVER, then the URL might look like this:

http://UTILSERVER/IDORequestService/ConfigServer.aspx

Or if you want to use secured http - a good idea if this server will be open to the internet for http traffic - use this format:

https://UTILSERVER/IDORequestService/ConfigServer.aspx

Master Site - See “Set Up the Master Site” on page 44.
3. On the Reports/TaskMan tab, specify the TaskMan Path for each intranet. This is the shared path to the TaskMan folder on the utility server used by that intranet (usually `\machinename\SyteLine`). Any time you change this field, you should restart all TaskMan services that monitor configurations for application databases connected to this intranet.
Define Linking Between Sites and/or Entities

Use the Sites/Entities form to define entities and sites in your system.

1. In all records for sites and entities that will be participating in non-transational replication, specify a system type. On the System Info tab, System Type field, select from the list you created in the System Types form. The system type you choose should exist at all of your sites and entities.

If this is a new Site/Entity record being added for non-transactional replication, specify additional information about the site or entity, as applicable, on this tab.

The Reports To (entity) field on this form is display-only. Reporting hierarchies are set up later through the Change Reports to Entity utility (page 63).

2. On the Site User Map tab, specify the SyteLine user name under which the local site (the one you are currently logged into) communicates with the target site (the site whose record is currently displayed). From Site is the local site. User Name is the local user that the local site specifies when using the IDO connection to perform the requested transaction on the target site. The user name and the password for that user must be the same on both the local and target sites. For now, specify the user name repl_user (set up on page 48) for all sites.
- For Site/Entity records where the current site/entity will perform **non-transactional** replication with the local site, the Site User Map tab looks like this:

![Site User Map non-transactional replication](image)

BC (the current record) is the "To" site and ILL (the local site) is the "From" site.

- For Site/Entity records where the current site/entity will perform transactional replication with the local site, the Site User Map tab looks like this:

![Site User Map transactional replication](image)

The tab is blank because no Site User information is required from ILL to CAL.
For the local site's Site/Entity record when the local site is also used as the replication "bootstrap" configuration for the utility server (see page 32), the Site User Map tab looks like this:

The Site User Map lists all the other sites on the utility server where replication will be "bootstrapped" from ILL (the local site).

For the local site's Site/Entity record when the local site is not used as the "bootstrap" configuration, the Site User Map tab looks like this:

No sites are listed in the Site User Map tab (because the CAL site does not replicate data to itself).
Set Up Replication Categories and Rules

1. Familiarize yourself with the default categories listed in the **Replication Categories** form. Be aware of what categories are available and what each one handles. See the **Multi-Site Planning Guide** for additional information about the categories.

2. At each site and/or entity, update the following categories:
   - Add the **NotesContentShadow** table to these categories: A/R, Centralized Order Entry, and G/L. This is required when using non-transactional replication, to replicate notes between sites.
   - Other than these changes, use the default categories "as is" for now. You may want to add to or modify the categories later when your system is up and running.

3. In the **Replication Rules** form at each site/entity, set up non-transactional rules for the **Site Admin** category between this site and all other sites and entities where non-transactional replication will take place.

   Add more non-transactional rules from this site/entity to other sites/entities, as appropriate.

   - For the **Interval Type**, select anything other than Transactional, and specify the appropriate interval and start date/time.
You should have created a **ReplicationRules spreadsheet** as part of your Planning phase. You can save time by importing the appropriate rules for each site from the spreadsheet into the grid on the form at that site/entity. See Appendix C, “Data Load To/From Spreadsheets,” for more information.

- If a rule refers to a site/entity that is not set up with matching information in the Sites/Entities form, the system will give a validation error when you try to save it.

4. At each site/entity, go to the **Replication Management** form and click **Regenerate Replication Triggers**.

![Replication Management form](image)

**NOTE:** Finish this step for all sites and entities before continuing with the next step.

### Populate Parameter _All Records at Other Sites

1. In the **Update _All Tables** form at each site and entity, repopulate the parameters _all tables.

![Update _All Tables form](image)

**TIP:** In an initialized database, the parameters tables already have one record defined for the local site. Because the record already exists, it will not be created at other sites through normal replication. Repopulating the tables ensures that a parameter record for the local site exists at other sites where it is needed.

   a. Click **Deselect All** to deselect all tables in the form.
b. Select the check boxes for the following parameters tables:
   - apparms_all
   - arparms_all
   - coparms_all
   - curracct_all
   - currency_all
   - currparms_all
   - dcparm_all
   - europarms_all
   - invparms_all
   - mrg_parm_all
   - parms_all
   - poparms_all
   - taxparms_all

c. Make sure nothing else is selected (including Disable Replication or a Site name).

d. Click Repopulate Tables. This repopulates each selected parameters _all table at the local site and also creates or repopulates the local site record at any other sites/entities to which the local site is replicating a category containing the parameter table.

TIP: At this point, it may be wise to back up all of your databases, so you do not have to re-add all of your replication setup if problems occur later in the implementation.
Setting Up Licensing at Sites and Entities

You should have requested and received the proper licenses for each of your sites and entities from your Infor representative. Use the Licensing spreadsheet from your Planning phase to help with this.

Intranet Licensing

If you do not plan to use intranet licensing, skip to “Site/Entity Licensing” on page 61.

Prerequisites

If you plan to use the Intranet Licensing feature, the following must be true. Instructions for all of these prerequisites are found in Chapter 5, “Setting Up Replication at Sites and Entities:

- You must have set up an intranet with a master site.
- All sites that will use the intranet licensing must be set up (in their Sites/Entities form) to use that intranet.
- All sites on that intranet must be replicating the Site Admin category, in order to recognize the master site.
- All sites that will use the intranet licensing must specify an application database name in their Sites/Entities form.

Turn on Intranet Licensing at the Master Site

1. At the master site only, log in and follow the steps under “Site/Entity Licensing” on page 61 to apply a license.
2. In the master site’s Sites/Entities form, select the Intranet Licensing check box on the local site record and save the record.

Turn on Intranet Licensing at Other Sites

1. Make sure all other users are logged out of the sites.

2. Log into any other sites where you want to use the master site’s licensing. On the Sites/Entities form at each site, select the local site record and select Intranet Licensing. Save the record.

Entities on the master site’s intranet should not select the Intranet Licensing check box. For entities, use the steps under “Site/Entity Licensing” below to set up licensing.

3. Log out of all the sites, including the master site, and then log back in. This picks up the changes to certain licensing records, which are now stored only on the master site. The licensing forms are now disabled in the non-master sites on the intranet.
Site/Entity Licensing

Perform the following steps at each site and entity. Or, if you are using intranet licensing, perform these steps only at the master site and any entities.

1. Go to the License Management form, where you will apply the appropriate licenses.
2. Select the Apply License tab.

3. Paste your license document into the License Document field. You can cut and paste the information from the license document into this field, or you can click the Browse button and select the document from your drive. The document is encrypted and every character counts, so if you copy and paste, make sure to copy the entire contents of the document.

4. Click Apply License. Any previous licensing that you had for this site is deleted and replaced with the licensing defined in the new license document.

The Licensed Modules tab should look similar to the following example after you apply your license; however, you may have different or additional modules licensed.

5. If there were active WinStudio sessions when you applied the license, perform the following steps. If there were not any active sessions, you can skip these steps.
   a. On the utility server, open the Configuration Manager (Start>All Programs>Infor>Tools>Configuration Manager).
b. Select the Utilities tab.

![Configuration Manager](image)

Path: `C:\Documents and Settings\My User\Application Data\Mongoose`

b. Select the Utilities tab.

c. Discard the Runtime Service Cache for all configurations that reference the application database to which the new license has just been applied. See the Configuration Manager online help for more information about the options on this tab.
Set Up the Financial Reporting Hierarchy

**NOTE:** Perform this step only if you are setting up a hierarchy of sites and entities.

1. **At each site and lower-level entity,** run the **Change Reports To Entity** utility and specify the entity to which this site/entity reports.

   - Use your **flowchart** from the *Multi-Site Planning Guide* when setting up this hierarchy.
   - If there is **only one** entity in the hierarchy, you do not need to run this utility at the entity.
   - You do not need to run this utility at the **highest-level** entity in the hierarchy.
   - If replication will be set up between a site and an entity, the rules must be set before running the Change Reports To Entity utility.
   - Before running this utility, make sure base currency and the chart of accounts match at the current site and the entity it will report to. (If this is a new site/entity, the chart of accounts will not yet exist.)
The site will be reporting to the new entity on the day after the **Cutoff Date**. This date cannot be earlier than the creation date of the site database.

During consolidation, the system will look for a currency exchange rate with the **Currency Translation Date** you specify here, and then uses that rate for the consolidation.

See the online help for additional information about using this utility.

2. After running this utility, verify whether the reporting hierarchy is set up correctly. Go to the **Sites/Entities** form at the highest-level entity and check whether the Reports To field displays as expected for each site and entity.

**TIP:** The Change Reports To data is replicated in the G/L or Ledger Consolidation categories (and the Reports To field is replicated in the Site Admin category). Replication should be set up so that your highest-level entity displays Reports To information in the Sites/Entities form for all sites and lower-level entities.
Set Up Accounts

1. In the Chart of Accounts form at the corporate (highest-level) entity, add all of your accounts. (If your system does not include any entities, set up the Chart of Accounts at each site.)

TIP: You may be able to input your accounts from a spreadsheet set up to match the form's grid view. See Appendix C, “Data Load To/From Spreadsheets,” for more information.

You cannot add the unit code information in the same spreadsheet as the account information, since they are different collections.

a. Be sure to add an account with an Account Type of Owner’s Equity to be used as your Cumulative Translation Adjustment (CTA) account.

b. Make sure that Inter-entity account numbers used for material transfers at sites that perform transfers with profit are different from your normal sales account numbers. This helps you know what to eliminate (as profit) when you consolidate to the entity level.

c. By default all unit codes are accessible for all accounts. If you want certain unit codes to be required or not accessible for certain accounts, specify that in the Chart of Accounts at the corporate entity. When you save the account record, a message similar to the following pops up for each unit code you marked as not accessible:

Click OK.
d. Do not set up information on the Unit Code 1-4 tabs yet. This information may be different for each account at each site/entity and will be set up later, after unit codes are defined.

2. If you have multiple levels of entities, do the following. If you have only one entity, or no entities, skip this step.

   a. At the corporate entity, use Multi-Site Chart Copy to copy the chart of accounts from the corporate entity to any mid-level entities that use the same (or similar) chart of accounts.

     ![Multi-Site Chart Copy](image)

     You may see the message "Account will be created." If so, click OK. When processing is complete, a message should indicate the number of accounts processed.

     If an error message displays while you are performing this step, see the information in the "Troubleshooting" chapter on page 112.

     If for some reason a different chart of accounts is required at the mid-level entity, then the chart of accounts may be created at the mid-level entity, setting up Reports To accounts to the corporate entity.
b. In mid-level entities, use the **Chart of Accounts** form to map each account to a "Reports To" account in the entity being reported to. You must do this in order for the Ledger Consolidation utility to work properly.

The existing accounts at the higher entity are listed in the Reports To Acct field drop-down. You can map to the same account or to a different account.

If the mid-level entity’s base currency is different from the higher entity’s base currency, you can specify the currency translation method to use when consolidating the account information. To comply with FASB52 or GAAP standards, you must set the currency translation method to Average for revenue and expense accounts and to End for asset and liability accounts.

3. Verify that the Chart of Accounts was automatically populated in each of the sites reporting to each entity. This is handled by ChartAcctRemoteSp in the Ledger Consolidation or G/L replication category.

TIP: Users cannot change the chart at the child sites, but they can update descriptions, delete accounts that do not apply to the local database, update obsolete/effective dates, and set up the Unit Code 1-4 tabs for the accounts.

4. At each site and entity, set up the unit codes that can be selected for each account.
a. Define unit codes on the **Unit Code 1-4** forms. See the help topic on "Account Unit Code (1-4)" for information about how unit codes are used.

![Unit Code 1-4 Form](image)

**TIP:** You may be able to input your unit codes from a spreadsheet set up to match the form’s grid view. See Appendix C, “Data Load To/From Spreadsheets,” for more information.

b. Run the **Copy Unit Codes to Accounts** form to copy a range of unit codes to a range of accounts. This fills in the information for each account on the **Chart of Accounts** form’s Unit Codes tabs at the site or entity. If an account is set up so that one or more of the unit codes is inaccessible, the utility does not populate those unit codes.

![Copy Unit Codes to Accounts Form](image)

**NOTE:** When you define unit codes for an account at any site/entity, we recommend that you also define the unit codes for the account at the entities it reports to. Otherwise, after consolidating the ledger transactions, the unit code is inserted into the unit code table at the entity but the description is not populated. Also, the unit code is not populated for the chart of accounts in the entity.
c. For greater efficiency, you may choose to copy all unit codes to all accounts in step b, and then go to the Chart of Accounts form to delete individual unit codes from certain accounts, as appropriate.

5. At all entities, in the Accounting Periods form, add accounting periods. (If your system does not include any entities, set up Accounting Periods at each site.)

**NOTE:** Accounting periods set at an entity will automatically populate each child site’s accounting periods (through Ledger Consolidation or G/L replication). If you have entities, you cannot update accounting periods at the site level. You will maintain the Current Period at all entities and sites.

**TIP:** Accounting periods must be set up manually at mid-level entities. You may want to export the accounting period grid at the corporate entity to a spreadsheet, to use when populating mid-level entities. See Appendix C, “Data Load To/From Spreadsheets,” for more information.

6. Make sure the Accounting Periods were replicated to the appropriate sites.
7. If you have multiple levels of entities, do this: at *mid-level entities*, run the **Verify Reports To Account Report**, turning off the "Invalid Accounts Only" flag so that all accounts are listed. Keep this printout for future reference. (If you have only one entity, or no entities, skip this step.)
Set Up Financial Statements

During the Planning phase, you should have determined where you want to run financial statements (at which level of entity, or at each site). Perform this step at those sites or entities.

Use the Financial Statement Definition form, along with the Financial Statement Definition Columns and Financial Statement Line Definition forms, to specify the content and format of a statement.

Once you have defined a statement, you can print it by specifying the Report ID in the Financial Statement Output form.

Reports you might design using the Financial Statement Definition form include:

- Balance Sheet
- Income Statement (Profit and Loss)
- Statement of Cash Flow
- Components of Working Capital
- Changes in Financial Position

See the online help topic titled "Financial Statement Setup" for the steps to follow.

SyteLine’s Excel-based toolset for financial reporting does not support multi-site or multi-currency situations. However, you can connect to any site or entity database and extract data into a spreadsheet using the toolset.
The following parameters and codes must be set up next, because they are used when creating the records in later steps. Any special implications for multi-site setup are explained below. Read the online help for each form to get additional details.

Set Up Site Groups

At all sites and entities, set up Site Groups for the various sites that will be doing centralized order entry, transfer orders, or financial reporting. Since Site Groups are replicated (in the Site Admin category), they can be set in one site or entity and will replicate to other linked sites/entities.

- One site group was set up with the Infor ERP SL Configuration Wizard on the database server, but the sites in the group might need tweaking, or you might want to define additional groups for additional purposes.
Set Up Countries and States

1. For each site and entity, go to the Countries form and add records for the countries listed on the Currency spreadsheet you created during the Planning phase, plus any countries that will be needed for the site/entity addresses on the General Parameters form (see page 77). You can also add other countries needed for customers and vendors.

   ! Country codes are replicated to other sites/entities if A/P, Shared Currency, or Centralized Order Entry categories are being replicated. So if you are maintaining currency information at one site or entity and replicating it to the others, you should enter your initial country list at the site/entity where you will maintain currency information.

   ! If the Activate EU VAT Reporting field is not selected on the General Parameters form, the EU and SSD EU fields are disabled here and do not allow data entry.

   ! When integrating SyteLine with other products via Infor On-Ramp, only ISO country codes can be passed in the BODs. If you are creating a new system, we recommend that you use the ISO country codes when defining new countries. If you already have existing non-ISO country codes, you can map them to ISO codes using this form.

2. For each site and entity, go to the Prov/States form and create province and state records to be used when you enter the company address in the General Parameters form for each site and entity database. You can also add other provinces and states needed for customers and vendors.

   ! Province/state codes are not replicated in any category.
Set Up Currency

1. For each site and entity, set up Multi-Currency Parameters. These are used as the default account values when you add new currency codes.

   - Domestic currency was determined when the database was created and cannot be changed.
   - This information is not replicated and must be entered at each site and entity.

2. For each site and entity, set up Currency Codes information.

   TIP: When you use this form, a message displays to indicate that you must log out of SyteLine after updating this information. However, you actually can continue through setting up the General Parameters (page 77) before logging out and restarting SyteLine.

   - Some currency information is replicated to other sites/entities if A/P, A/R, Shared Currency, or Centralized Order Entry categories are being replicated. So if you are maintaining currency information at one site or entity and replicating it to the others, you should enter your initial currency codes at the site/entity where you will maintain currency information.
When integrating SyteLine with other products via Infor On-Ramp, only ISO currency codes can be passed in the BODs. If you are creating a new system, we recommend that you use the ISO currency codes when defining new currencies. If you already have existing non-ISO currency codes, you can map them to ISO codes using this form.

The currency codes, formats and rates are replicated with any of the above categories, but the related account information is not replicated.

Use the **Currency spreadsheet** you created during the Planning phase.

3. If you enter additional currencies beyond the domestic currency, then when you save the record the system asks if you want to run the Currency Rates form to create rates for the new currency codes. Click **Yes**.

4. For each site and entity, on the **Currency Rates** form, specify the appropriate rates between the domestic currency and any other currencies. Rates can be modified later.
Set General Parameters

For each site and entity, go to the General Parameters form.

TIP: Some general parameter information for each site may be replicated to other sites and stored in the parms_all table. None of that information from other sites is displayed on this form, however.

1. On the Address tab, enter the company address to be used for the entity or site. The name and address entered on this tab displays on invoices, checks, credit/debit memos, payroll and tax documents, and so on.

2. On the General tab, specify at least the following options. Many of the parameters here turn on/off other features and fields in SyteLine. Read the help carefully to select the options you need.

- Update the Current Fiscal Year.
- Specify a multi-site group. This becomes the default value used in the Site Group field on reports and utilities.
- Optionally, specify a transfer/project BOL prefix. Site-specific prefixes may make it easier to determine which site originated an advance ship notice.
For the *Corporate entity only* - when there are multiple levels of entities - specify the CTA Account. This account is used to store the currency translation differences that might occur during the consolidation of accounts to this corporate entity.

**NOTE:** The CTA account can only be set up after the Reports To Entity hierarchy is set up (see page 63).

3. Log out of the site/entity and then log back in. Changes to the currency codes and the general parameters require this.
Set Up Bank Codes

At each site, you must set up at least one bank code. If A/P checks will be written in multiple currencies, you must set up a bank code representing each currency. Use the Bank Reconciliations form to do this.
Set System Parameters

1. At all sites that will be transferring items or material to other sites, use the Inter-Site Parameters form to establish the relationship between sites and to identify the inter-company account numbers to use during transactions - see the help topic "Moving Items or Materials Between Sites."

- This form must be filled out prior to any multi-site activities taking place. Enter the information in one site, and most of the information in the records is added automatically at other sites where Site Admin is being replicated.

- On the General Tab, define the following:
  - Posting Method - Although your choice here is "intra-entity" or "inter-entity," this setting really has little to do with entities. It determines how accounting transactions between the sites are handled. Think of "intra-entity" as "at cost" and "inter-entity" as "with revenue."
  - Price Code - may be selected here but is not defined yet. Return to this form and select a price code later. The price code is only used when the Posting Method is inter-entity.
  - Exchange Rate - The exchange rate is only used when the To Site and the From Site have different base currencies.
  - The accounts listed at the bottom of this tab are used only when the Posting Method is intra-entity.
  - The information on the Ship From, Ship From COS, and Receive To tabs is used only when the Posting Method is inter-entity.
  - The information on the Payment Tab is used only for A/P and A/R payments.
2. At the sites, set up **Accounts Receivable Parameters**.

- You must specify a multi-site group on this form. Only records for sites in this group are considered when performing Accounts Receivable payments and quick invoice payments, and when consolidating A/R posted transactions.

- You could set up a customer prefix that indicates the originating site as well as the type of record. For example, you could use CI as the prefix for customer numbers local to the ILL site and CC for customers local to the CAL site. If you have global customers, you could have one site that can create only global customers, and use the prefix CG in that site. For more information about prefixes, see the *Multi-Site Planning Guide*.

- A credit hold reason code may be specified here but is not defined yet. You can return to this form later to select the appropriate code.
3. At the sites, set up **Accounts Payable Parameters**.

- You must specify a multi-site group on this form. Only records for sites in this group are considered when performing Accounts Payable payments and quick voucher payments, and when consolidating A/P posted transactions.

- You could set up a vendor prefix that indicates the originating site as well as the type of record. For example, you could use the prefix VI for vendors local to the ILL site and VC for vendors local to the CAL site. If you have global vendors, you could set up one site that can create only global vendors, and use the prefix VG in that site. See the **Multi-Site Planning Guide** for more information about using prefixes.

4. At the sites, set up **Order Entry Parameters**.
Specify the invoice number length in the Invoice Length field. We recommend that you set this field to 12, which is the maximum.

**CAUTION:** The invoice number length must be the same for all sites in the system. It must be set at each site; it cannot be replicated to the other sites. When you enter a value here, the system verifies it against the Invoice Length value set for other sites - if the other sites are replicating at least one category containing the coparms_all table with this site.

Once the Invoice Length field is set to a non-null value, the value can never be updated.

After you save the change, the system updates about 50 database tables, so it may take a long time to process.

- Site-specific prefixes are recommended if Centralized Order Entry or Accounts Receivable payments across sites will be performed. See the information on prefixes in the *Multi-Site Planning Guide*.
- If the Price From Originating Site field is selected, default item prices for CO lines are pulled from the site originating the order. This allows you to maintain pricing in one centralized site. Otherwise, the system pulls the default prices from the site shipping the order line item.
- When you save this record, you may see a message asking you to perform manual replication of A/R data. If so, go to the Manual Replication Utility, select the A/R category, and select the site(s) to which A/R data is being replicated. This ensures that the required data is in the proper tables at the other sites.

5. At the *sites*, set up **Purchasing Parameters**.

Site-specific prefixes are recommended if Accounts Payable payments across sites will be performed. See the information about prefixes in the *Multi-Site Planning Guide*.
6. At the sites, set up **Transfer Order Parameters.**

![Transfer Order Parameters](image1)

- Site-specific prefixes are recommended to make it easier to determine which site initiates a transfer order. See the information about prefixes in the *Multi-Site Planning Guide*.

7. At the sites, if you will be using MRP or APS, set up **Planning Parameters.**

![Planning Parameters](image2)

- Refer to the online help and the *Infor ERP SyteLine APS Configuration Guide* for information about how to set up these parameters for use in a multi-site environment.
8. At the *sites*, go to the **Master Explorer**>**Codes**>**Parameters** and open the other parameters forms you have not yet accessed, to set up parameters appropriate for your system.

- Depending on your system, you may not need to set up some of these parameters.
- Some forms may require selection of data that is not yet set up. If so, return to finish the setup of those forms later.
- When a Prefix field appears on a parameter form, you may want to specify a site-specific prefix where appropriate, as described for the other parameter forms above.

9. After updating all parameters, log out of *each site/entity* and then log in again. This updates system variables so they contain the latest parameter information.
Perform the following steps at each site and entity to set up users.

If you are using Intranet Licensing, the users at all sites must also be defined at the master site. Then the users must be assigned to license modules on the master site (through the User Modules form).

**Update the "sa" User**

On the **Users** form, select the "sa" user and add the **Enter Out of Date Range** group authorization. This authorization can be used to limit journal entries incorrectly created to the wrong accounting period.

You also may be asked to select a Site Group for this user. Since this is a Super User, the group you choose does not matter.
About the SL_Internal User

The SL_Internal user exists in every site. It is a multi-session internal user. You should not have to modify any information about this user.

Set Up Password Parameters

At each site and entity, use the Password Parameters form to specify password expiration and complexity rules for all users. Be sure to explain the rules you choose to the users of your system.

The password parameter data is replicated as part of the Site Admin category.
Add Common Users

1. In the **Users** form at *each site* and *entity*, set up other common users - those who will be working in multiple sites. You can also set up local users now, if you want.

These users are in addition to the sa and SL_internal users (and the repl_user, if set up in Chapter 5, “Setting Up Replication at Sites and Entities), which have full access to the local site or entity.

- You must specify a default authorization group for each user.
- For *entity* users, the authorization group should be **Entity Forms**. This will prevent users from doing anything in the entity that is not supposed to be done in an entity database.
- For *site* users, select an authorization group. For now, select one or more of the default authorization groups from the drop-down list. (Later, after you become more familiar with the system, you may want to set up new groups that more closely resemble your needs. Do not change the default groups!)
- To find out which forms are included in each default authorization group, go to the **Groups** form. Select a group and then click the **Group Authorizations** button to list the forms that members of this group can access.
- If you do not set up at least one authorization group for a user, then the user has access to no forms - unless the user is set up with super user access.
- You must specify a default multi-site group for each user. This is the default value that appears in the Multi-Site Group field when this user opens the Item Availability form.
You cannot replicate the usernames or groupnames tables because those tables use identity columns. However, to simplify the initial setup of multi-site users, you could add the multi-site users and groups in one site, export the data to Excel spreadsheets, and import into other sites and entities. (See Appendix C, “Data Load To/From Spreadsheets,” for more information.)

User password, email address, and workstation login can be set up in one site and replicated to the rest (through the UserNamesRemoteUpdateSp in the Site Admin category). However, the user record, assigned user module, authorization group and other required fields must already be set up at the individual sites and entities.

Employee Number and warehouse (Whse) may be specified here but are not defined yet. You can return to this form later to select the appropriate data.

2. From the Users form, click the User Authorizations button to display the Object Authorizations for User form, where you set up object authorizations for each new user record. Settings made here override any group authorizations for this user.

Some of your users may require special access to certain forms that is not covered in the default group authorizations. For example, the user robertz is in the Purchasing authorization group, which has full access to the Purchase Orders form. However, you do not want to allow robertz to delete POs.
3. If you decided during the Planning phase to use named user licensing, return to the Users form and select a user record. Click the User Modules button to go to the User Modules form where you can set up licensing for the selected user.

Repeat this step for each user in the site or entity. Use the Licensing spreadsheet from your Planning phase to help with this.

If you are using Intranet Licensing, the User Modules form is available only at the master site and not at the participating sites.

See the chapter on licensing in the Multi-Site Planning Guide for more information about how licensing works.

Copy Users

If you have many common users between sites, you can set them up in one site and then use the Copy User Table utility to copy them to other sites. To access this utility on the utility server, go to the Start menu and navigate to All Programs>Infor>Tools>Copy User Tables.

For more information about the utility, see the Infor ERP SyteLine Administration Guide.

Adding External Users

External customers or suppliers may be added as users on particular sites. (Since they will log in remotely via the internet, the web server through which they will log in should be configured to use https, so that data being transferred over the intranet is encrypted.)

Set up these users in Infor ERP SyteLine using authorizations that limit their access only to the specific forms you want them to view. You may also want to limit their object authorizations to view-only, as described on page 90.
Setting Up Supporting Data

In each site, set up the following data. The forms listed below add data to supporting tables that are used when entering customer, vendor, and item information, creating transactions, and so on. Your company may not use some of the following data; in that case, you can skip those forms.

NOTE: Be careful about the order in which the data is defined, so that table dependencies are not violated, which will prevent records from loading. For example, product codes must be defined before distribution accounts are defined - both of which must precede the definition of items. Items must be defined before routings, BOMs, CO and PO lines, jobs, and so on.

The forms are generally listed in the order the data should be entered because of data dependencies.

- Offices
- Companies - optionally includes CEO (from Employees, which is not available until later)
- Divisions - requires Company and Office, optionally includes Div Manager (from Employees, not available until later)
- Departments - optionally includes Company, Office and Manager (from Employees, not available until later)
- Price Codes - you might want to skip until later when items are defined
- Project Cost Codes
- Product Codes - optionally includes Price Code and Project Cost Code.

Even though the account fields are not required fields in this form, you must specify them now. When you add items later, the product cost requires these associated accounts.

- Nature of Transaction Codes (NOTC)
- Secondary NOTC
- Ship Via Codes
- Delivery Terms
- Warehouses - optionally includes Prov/State, Country, NOTC, Secondary NOTC, Delivery Terms and Ship Via
- Distribution Accounts - requires Warehouse and Product Code (In-Transit account values default from the product code)
- Tax Codes - requires Tax System - but there is a default Tax System 1 defined here, optionally includes Tax Jurisdiction
- Tax Systems - requires Tax Code
- Tax Jurisdictions - requires Tax System, optionally includes EC Code (from Countries form) and Vendor number (not available until later)
- Billing Terms
- Reason Codes - there are many of these - use Form>Open and filter on reason to find them all. Some of them optionally include NOTC and Secondary NOTC
- Scheduling Shifts
- Resource Types
- Resources - requires Resource Types and Shift Exception ID, optionally includes Item (not added until later), Scheduling Shift, Fixed Asset Number (which in turn requires other data)
- Resource Groups - requires Resources
- Work Centers - requires Department, optionally includes Scheduling Shift and Resource Group
- Locations - optionally includes Work Centers
- Unit of Measure Codes - some U/M information is replicated between sites when the sites are replicating the Centralized Order Entry, Inventory/Transfers, Purchase Order Builder, or Voucher Builder categories
- Shift Codes
- Commodity Codes
- Language IDs
- Multi-Lingual Ship Via
- Multi-Lingual Terms
- Unit of Measure Conversions - requires Unit of Measure Codes
- End User Types
- Vendor Categories
- Fixed Asset Class Codes - optionally includes Department
- Printers

Simplifying the Data Load Process

In many cases, you can create a spreadsheet based on the grid view of a form to copy and paste the supporting data into SyteLine. See Appendix C, “Data Load To/From Spreadsheets,” for more information.
Setting Up Operational Data

Data Loads and Replication

CAUTION: If the following statements are true, you may want to turn off replication before loading operational data, in order to speed up the data load:

* You are loading large amounts of data into tables, AND
* Those tables have triggers replicating to _all tables, AND
* Your system is replicating those _all tables between sites, AND
* Those _all tables reside at the local sites rather than at one master site.

Also, if there are possible conflicts between data records being loaded at different sites (for example, different customers with the same number), you may want to turn off replication before loading the data, in order to minimize errors.

In these cases, go to the Sites/Entities form’s Link Info tab and disable replication between sites before loading the data.

After the load is complete, enable replication and run the Manual Replication Utility for the necessary replication categories.

Set Up Shared Customers, Vendors, and Items

You may want an administrator to control adding, updating, and deleting shared customers, vendors, and items across the system. Keep in mind that each site can control its local customer records, and these records are independent of other sites.

Add Shared Vendors Using a Master Site

If you have set up a master site, use the Multi-Site Vendors form at the master site to add vendors for all sites in the intranet. Instructions for using this form are in the online help. Appropriate replication rules must be set up between the sites in order for the form to work.

See the chapter on Master Sites in the Multi-Site Planning Guide for information about the replication rules required.

Add Shared Customers, Vendors, and Items Without a Master Site

As described in the Multi-Site Planning Guide, some customer, vendor, and/or item data may be replicated when a new customer, vendor or item is added. However, the new
record does not automatically appear in the Customers, Vendors, and Items forms at the other sites. You must add it as described below.

**Add Shared (Global) Customers - No Master Site**

When a customer record is added in one site, it does not automatically populate in other shared sites. If you want a customer to exist in multiple sites, first create it in one site and then add the existing customer into other shared sites using these steps:

**NOTE:** In the following description, "sharing sites“ means the Centralized Order Entry category and/or the A/R category are being replicated between the sites.

1. In one site, go to the Customers form. Add and save the new customer records. The customer number and name is replicated to sharing sites.
2. At the other sites, go to the Customers form and select Actions>New.
3. Enter the customer number or select it from the drop-down list. The customer name and address displays.
4. You must then fill in the rest of the information manually in the Customers form at the sharing site.

**Add Shared (Global) Vendors - No Master Site**

When a vendor record is added in one site, it does not automatically populate in other shared sites. If you want a vendor to exist in multiple sites, first create it in one site and then add the existing vendor into other sharing sites using these steps:

**NOTE:** In the following description, "sharing sites“ means the the A/P or Voucher Builder category is being replicated between the sites.

1. In one site, go to the Vendors form. Add and save the new vendor records. The vendor number and name is replicated to sharing sites.
2. At the other sites, go to the Vendors form, select Actions>New.
3. Enter the vendor number or select it from the drop-down list. The vendor name displays.
4. Fill in the rest of the information manually in the Vendors form at the sharing site.

**Add Shared (Global) Items - No Master Site**

When an item record is added in one site, it does not automatically populate in other shared sites. If you want an item to exist in multiple sites, first create it in one site and then add the existing item into other sharing sites using these steps:

**NOTE:** In the following description, "sharing sites“ means the Centralized Order Entry category and/or the Inventory/Transfers category are being replicated between the sites.

1. In one site, go to the Items form and add and save the items.
2. The item numbers, descriptions and U/M values are replicated to sharing sites - but the new items will not automatically appear in the Items form at the sharing sites. This information will, however, appear in the sharing sites’ Global Items form.
2. In the sharing sites, go to the **Items** form and select **Actions>**New.
3. Enter the item number or select it from the drop-down list.

The system enters the default values from the **Global Items** form into these fields: Item, Description, and U/M.

4. Fill in the rest of the item record manually at the sharing site.

The **Global Items** form also contains a default Shipping Site, which is used to determine how the Customer Order Line ship site defaults when entering a centralized order for the item.

Typically, shared sites have identical Global Items default values when all sites are within the same country. If sites are in different countries, the Description and U/M fields can be updated as required.

---

**Alternative Methods - Copying Records**

Another way to duplicate vendor, customer or item records in multiple sites is to create the records in one site, export them to a spreadsheet, and import the spreadsheet into the same form at the new site. (Make sure the form's grid columns are arranged in the same order at both sites.) See Appendix C, "Data Load To/From Spreadsheets," for more information.

If your sites are accessible through a single computer, you also may be able to use the right-click Copy feature to copy the item rows from the Customers, Vendors, or Items form on one site and then use **Edit>Paste Rows Append** to add them at the other site.

---

**Set Up Employees**

In the **Employees** form, enter information about each employee. Fill in at least the required fields, which are used in other areas of the system.

---

**Set Up Other Operational Data**

1. In each site, set up the following:
   - Current routings and BOMs
   - Customer Orders
   - Customer Order Lines
   - Purchase Orders
   - Purchase Order Lines
   - Jobs
   - Job routings
   - BOMs

2. In each site, set up beginning balances for accounts in the **Journal Entries** form.
Once you have your basic SyteLine multi-site system set up, you can install and configure other modules and products according to the documentation listed below:

<table>
<thead>
<tr>
<th>To set up this</th>
<th>Refer to this information</th>
</tr>
</thead>
<tbody>
<tr>
<td>APS</td>
<td>Infor ERP SyteLine Installation Guide, online help</td>
</tr>
<tr>
<td>Application Event System</td>
<td>Infor ERP SyteLine Guide to the Application Event System, online help</td>
</tr>
<tr>
<td>Business Intelligence</td>
<td>Infor ERP SyteLine Business Intelligence Installation Guide, online help</td>
</tr>
<tr>
<td>Configuration</td>
<td>Infor ERP SyteLine Infor Configuration Integration Guide</td>
</tr>
<tr>
<td>Data Collection</td>
<td>Infor ERP SyteLine Installation Guide, TRAKKER Antares Reader Installation Guide, online help</td>
</tr>
<tr>
<td>EDI</td>
<td>Online help</td>
</tr>
<tr>
<td>Enterprise Financials</td>
<td>Infor ERP SyteLine Enterprise Financials Interface Installation and Setup Guide</td>
</tr>
<tr>
<td>Epiphany CRM</td>
<td>Epiphany CRM SyteLine Integration Guide</td>
</tr>
<tr>
<td>.NET Web Service</td>
<td>Infor ERP SyteLine Installation Guide</td>
</tr>
<tr>
<td>Online help</td>
<td>Infor ERP SyteLine Installation Guide</td>
</tr>
<tr>
<td>PLM</td>
<td>Online help</td>
</tr>
<tr>
<td>PM10</td>
<td>Infor ERP SyteLine PM10 Integration Guide</td>
</tr>
<tr>
<td>Infor ERP SyteLine FAX Service</td>
<td>Infor ERP SyteLine Installation Guide</td>
</tr>
</tbody>
</table>
Handling Replication Errors

Errors During Transactional Replication

Validation errors relating to transactional replication generally display during data entry or saving of transaction records at the local site, and do not allow the user to continue.

However, if transactional replication appears to not be working (that is, the data isn’t being moved to the target site as expected) and the cause is not immediately apparent, use the “Replication Troubleshooting Checklist” on page 102 to help find the problem.

Errors During Non-Transactional Replication

If errors occur when sending or receiving XML request documents through SyteLine’s replication system, the following processes handle the errors.
Replication Troubleshooting Checklist

**Problem:** *Replication does not seem to be working.* For example, a newly added item is not available from a drop-down menu in another, replicating site.

**Solution:** View the appropriate _all table(s) using SQL Server tools, to determine if data is being populated. For our example problem above, view the item_all table. If replication is not working, the table typically will not contain the newly entered data records. In this case, there probably is a problem with the replication rules.

For replication problems, check the following areas:

1. **Replication Rules** form (page 41 and 56) - Make sure the rules are set up properly between the site where the data was added and the one where it was supposed to appear.

Are the proper categories being replicated? Use the following table to see what types of results to expect on the target site for each replicated category.

<table>
<thead>
<tr>
<th>Category</th>
<th>Expected results on target site (for forms with Site or Site Group fields)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/P</td>
<td>Posted A/P vouchers, adjustments and payments from source sites are visible on view forms. A/P reports contain data from source sites. _all tables contain account, currency, item, journal, period, vendor and tax information from source sites.</td>
</tr>
<tr>
<td>A/R</td>
<td>Posted A/R invoices, debit memos, credit memos and payments from source sites are visible on view forms. A/P reports contain data from source sites. _all tables contain account, currency, item, journal, period, customer and tax information from source sites.</td>
</tr>
<tr>
<td>Centralized Order Entry</td>
<td>Customer orders with lines that have a local ship site are visible. Transfer orders to or from the local site are visible. _all tables contain customer, customer order, account, currency, item, job, period, purchase order, project, transfer order and tax information from source sites.</td>
</tr>
<tr>
<td>ESB</td>
<td>Data is received in other Infor On-Ramp enabled application; acknowledgement data is received in SyteLine.</td>
</tr>
<tr>
<td>EXTFIN Customer</td>
<td>Not typically used between SyteLine sites.</td>
</tr>
<tr>
<td>EXTFIN Vendor</td>
<td>Not typically used between SyteLine sites.</td>
</tr>
<tr>
<td>G/L</td>
<td>Financial and G/L reports and views show data from source sites. _all tables contain ledger, account, currency, period, and journal information from source sites.</td>
</tr>
<tr>
<td>Inventory/Transfers</td>
<td>Transfer orders to or from the local site are visible. _all tables contain account, currency, item, job, period, and transfer order information from source sites.</td>
</tr>
<tr>
<td>Journal Builder</td>
<td>Pending journal transactions created by Journal Builder in source site appear in the local site. Journal Builder site can validate data from the local site.</td>
</tr>
<tr>
<td>Ledger Consolidation</td>
<td>Ledger records are consolidated from source sites when invoked. _all tables contain account, currency, and period information from source sites.</td>
</tr>
</tbody>
</table>
a. View the Replication Rules form in the source site (for example, if you're expecting to see CAL data in ONT, view the CAL database), and determine if there is a rule set up with Target Site equal to the site where you expect to see the data, and with Category equal to the category as determined above.

b. If such a record does not exist, this means the behavior was expected. You can create a new rule if desired, and retest to verify that the data was passed over.

c. If the record exists, check its Interval Type:
   - If the Interval Type is Transactional, there may be another problem with the replication setup. Continue through the other steps in this check list.
   - If the Interval Type is Immediate, there may be a problem with the setup of the replication services.
   - If the Interval Type is something other than Transactional or Immediate, wait until the time specified in Start Interval At before testing again. If the interval time has passed and the change has still not occurred on the target machine, there may be a problem with the setup of the replication services.

2. **Sites/Entities** form (page 41 and 56) - Make sure the database name and the linked servers (for transactional replication) or user maps (for non-transactional replication) are set up correctly.

3. **Replication Management** form (page 42) - You must click the Regenerate Replication Triggers button on this form after any replication rules have been changed. Failure to do so will result in replication not working properly.
4. **Find Replication Setup Issues** form (page 110) - Use this form to find problems relating to the setup of replication from the current site to another site/entity for a particular database table or stored procedure.

Not all problems found by this utility are valid in all situations. For example, it checks to see if a user name is set up between the sites - which applies only if non-transactional replication is being used.

5. **Replication Errors** form (page 109) - This form shows the data that failed to submit to a target site during non-transactional replication. Use the form to fix and resubmit data, or delete it.

6. **Replication Tool** (page 107) - This tool on the utility server is used to troubleshoot non-transactional replication.

7. **ReplicatedRows3** and **ShadowValues** tables - When something is to be replicated through *non-transactional* replication, it gets copied to the ReplicatedRows3 and ShadowValues tables. (See the *Replication Reference Guide* for details.) If the data is not there, it is likely that either your replication rules aren’t set properly or that you need to click the Regenerate Replication Triggers button on the Replication Management form.

8. **Services** - If you are using *non-transactional* replication, make sure the Infor Replication Queue Listener and Infor Replicator services are started on the utility server.

9. **MSMQ** or **Message Queuing** - Turn on journaling.

10. Check the replication logs under the **Infor ERP\Logs** folder. These are useful for non-transactional replication.

11. **Event Viewer** - Check the event viewer in the Windows Administrative Tools on the utility server or database server. The events that are logged may give you a clue about where replication failed.

12. **UETs** - If you are using user extended tables, and the UET information is not replicating properly, see the information about UETs and _all tables in the *Replication Reference Guide*.

**Common Replication Solutions**

**Problem:** *System performance is slow and you suspect replication may be causing this.*

**Solution:** Check the following:

1. Use the stored procedure **sp_spaceused** (in the Master database) to determine which tables consume a lot of space.
2. If there are _all tables (that is, replicated data) that contain very large numbers of records, then make sure you are not replicating unnecessary data. See the Replication Categories chapter in the Replication Reference Guide, particularly the information about replicating financial data.

Also look at the descriptions of how the tables in each category are used. If your large _all tables are used only for reports that you rarely or never require, you may be able to remove that object from the category.

**NOTE:** Before making changes to replication categories, seriously consider requesting help from your SyteLine provider or Infor Professional Services.

3. See also the information on improving system performance in the Infor ERP SyteLine Administration Guide.

**Problem:** Replication failure due to SQL Linked Server error. If your system returns an error like one of these, the local server probably no longer has a link to itself:

- Server 'servername' is not configured for Data Access. Distributed Transaction Completed. Either enlist this session in a new transaction or the NULL transaction.
- New transaction cannot enlist in the specified transaction coordinator.
- The operation could not be performed because the OLE provider 'SQLOLEDB' was unable to begin a distributed transaction.

**Solution:** To fix this problem, run the following SQL commands on the App database:

```sql
exec sp_addserver servername, LOCAL  
-- restart SQL Server.
EXEC sp_serveroption 'servername', 'Data Access', 'True'
```

Replace `servername` with the name of the local server.

**Message:** Invalid Column name UF_xxxx. If your system returns an error message similar to this during replication, you may have user extended tables (UETs) set up in one site but not in another.

**Solution:** You must have identical schemas in all sites and entities to replicate data. If your system includes User Extended Tables (UETs), consider the following when replicating data to other sites.

If one site contains UET modifications to a table, but the same table in another site does not contain those modifications, errors probably will be generated during replication of that table’s data from one site to the other.

For that reason, before you replicate data between sites, you should copy any UET schema changes to all sites involved in the replication. A stored procedure, ExportUETClassSp, assists in handling this process. See the document Modifying Infor ERP SyteLine for more information and a copy of the script used to create the stored procedure.
Problem: **Outbound BODs are not being sent from SyteLine to another system.**

Solution: Follow these steps to determine the cause:

1. Does the BOD appear in the Replication Document Outbox?
   
   (BODs are saved in the outbox after processing only if the SyteLine component definition in Infor DCA has the poller.deleteProcessing property set to false.)

   If Yes, continue to the next step.

   If No, then do this:

   a. If this is a multi-site system, verify that you are checking the inbox on the "bootstrap" site; that is, the site defined in the configuration designated as the bootstrap in the Service Configuration Manager utility.
   
   b. From the SyteLine utility server, run the LogMonitor utility.
   
   b. In the SyteLine application, perform the processing that should send the BOD. (See the Replication Document Outbound Cross References form for a list of the application events that generate the BOD.)
   
   c. In the LogMonitor utility, look for ReplQListener log information that might indicate an error in the BOD processing.

2. Is the Processed check box selected?

   If Yes, the BOD was picked up by Infor On-Ramp. Check Infor CSI: Errors > History to find failed message transmissions and information about why the failure occurred.

   If No, then there is a problem that is preventing On-Ramp from picking up the message; either the On-Ramp is not running or the configuration and deployment of the sending/receiving applications is not set up properly in Infor DCA and DEM.

Problem: **Inbound BODs are not being received or processed by SyteLine.**

Solution: Follow these steps to determine the cause:

1. Does the BOD appear in the Replication Document Inbox?

   (If there are many documents in the inbox, it may be difficult to find the BOD because currently you can’t filter by BOD name.)

   If Yes, continue to the next step.

   If No, then something prevented it from being delivered by Infor On-Ramp:

   - If this is a multi-site system, verify that you are looking at the inbox on the site designated in the Inbound Bus Configuration field of the Service Configuration Manager.
   
   - Check Infor CSI: Errors > History to find failed message transmissions and information about why the failure occurred.
   
   - Check whether the On-Ramp service is running.
   
   - Check whether the configuration and deployment of the sending/receiving applications is set up properly in Infor DCA and DEM. See the appropriate integration guide for more information.
2. Is the Processed check box selected?

If Yes, and the expected information does not appear in the appropriate SyteLine form or table, then there was an error in processing. Check the Replication Document Outbox for a Confirmation BOD. A confirmation BOD indicates an error. Check the following areas to determine the cause of the error:

- Windows application event viewer
- LogMonitor utility on the utility server, if it is running
- Infor CSI: Errors > History (contains information from the confirmation BOD)

If No, then either the Infor Framework Inbound Bus Service is not running, or it is still working through previous messages.

**Problem: Error in Replication Document Manual Request Utility due to timeout**

If you receive either of the following errors during generation of BODs through the Replication Document Manual Request utility, then transactions are taking longer to run than the timeout values set in SyteLine or other related applications and services.

```
Exception from load collection: Error processing an IDO request
```

or

```
The transaction has aborted. Transaction Timeout
```

**Solution:** For a list of timeout values that can be reset, see the chapter on improving performance in the *Infor ERP SyteLine System Administration Guide*.

**Forms and Utilities Used to Troubleshoot Replication**

**Replication Tool (Inbound or Outbound Flow)**

If errors happen while SyteLine replication is processing an inbound or outbound request, you can use the Replication Tool on the utility server to:

- View, correct, and resubmit inbound and outbound XML request documents
- View the status of sites linked to this site for replication
The Replication Tool can be used to view errors in any XML being sent from SyteLine to a
different SyteLine intranet or an external system. To start this tool on the utility server,
navigate to Infor>Tools>Replication Tool from the Start menu.

Service Configuration Manager (Setup)

Before you run the Replication Tool, use the Service Configuration Manager utility
(Infor>Tools>Service Config Manager from the Start menu) to configure replication
options on the Replication tab. Then click the Save button to save these settings in the
service configuration XML file specified on the General tab.

Instructions for using the Replication Tool and Service Configuration Manager are found in
their online help.
Replication Errors Form (Inbound Flow)

During non-transactional replication, if an XML document makes it into a SyteLine intranet, is retrieved from the inbound MSMQ by the Replication Queue Listener, but fails when executed against the target site, its errors are displayed in SyteLine’s Replication Errors form on the target site. Generally these documents contain valid login and target site information but are failing for another reason.

If an inbound XML document fails before that point, you can view and correct it through the Replication Tool described above.

Use the form to fix and resubmit the data. If the update succeeds this time, the data is removed from the ShadowValuesErrors table; if it fails again, it will remain in the table.

The fields of interest are:

- **From Site** - Site where the record orginated.
- **Object Name/Object Type** - Name and type of record to be replicated (for example, co table).
- **Operation Number** - Distinguishes different elements in the errors. For example, an insert of an item record might use several lines of old and new values, all with the same Operation Number.
- **Operation Type** - Type of operation: insert, update, delete, or method call.
- **Line** - Indicates which line of data for a particular record contained the error. The data is stored in rows of 55 name/value pairs, so for example, if there are 85 columns of data, there will be 2 lines.
- **Old/New** - Indicates whether a particular row of the collection represents the old or new values. For updates, the old values are also displayed.
- **Error** - Text of the error message received when this record was submitted.
- **Label** - Label seen on forms.
- **Value** - Data for a particular column. For example, the column "Description" might have data "bike seat" as a value.
Find Replication Setup Issue

If you know that a specific object (for example, the item_all table) is not replicating changes from the current site to another site, use this form to help troubleshoot why replication is not occurring.

You enter an object name and type (a table, stored procedure, or XML document) and select the remote site name. When you click the List Issues button, any setup errors for that site/object combination are listed.

Some of the setup problems that may be displayed include:

- The From Site or To Site does not exist in the site table.
- No replication category contains the specified object (table, SP, etc.).
- No replication rule exists for the specified From Site and To Site, and for any category that contains the specified object.
- A rule exists for a category using the specified object, but the rule is currently disabled on the Replication Rules form.
- Replication is currently disabled between the specified From Site and To Site on the Sites/Entities form.
- No replication trigger exists for the specified object (if it is a table), or the trigger is disabled.
- The To Site has not been set up with a linked server name on the Sites/Entities form or through the Infor ERP SL Configuration Wizard. (Transactional replication)

NOTE: Transactional replication checks are made only if at least one transactional replication rule is enabled at this site.

- The To and From sites are on different database servers, and the To Site’s database server has no link to it from this site’s database server. This is established through the Linked Servers node in SQL Server. (Transactional replication)
- The To Site’s database name is not specified on theSites/Entities form. (Transactional replication)
- The user name specified for this From Site and To Site does not exist. (Non-Transactional replication)
- The replication user name is not a super user or has not been given access to the proper license module and group. (Non-Transactional replication)
- The To Site and/or From Site does not have an Intranet defined on the Sites/Entities form. (Non-Transactional replication)
- The To Site's intranet has no URL defined on the Intranets form. This is a problem only if the To Site is on a different intranet than the From Site. (Non-Transactional replication)

If no problems are found, the replication triggers may just need to be regenerated.
Troubleshooting Other Setup Problems

You may encounter other error messages during implementation. One common message and its solution is described below.

**Message: Maximum Number of Databases Used for Each Query has been Exceeded**

Close and restart the Infor ERP SyteLine session where the error occurred. Retry the procedure you were running at the time of the error.

If you still get the error, close all open Infor ERP SyteLine sessions and restart only the one for the configuration you were in when the error occurred. Retry the procedure that caused the error.

Framework Logging

All framework logging, from sources such as as WinStudio, TaskMan, Replicator, and the IDO Runtime Service, is sent to a common logging routine. This log information can be viewed on the utility server through the Log Monitor (`Start>All Programs>Infor>Tools>Log Monitor`).

Note that information sent to the logs while the Log Monitor program is not running is not stored anywhere. If a developer is using the IDO Runtime Development Server instead of the Log Monitor, that program displays logging information.
NOTE: Refer to the Support Web site for the latest information on requesting license keys for demo or pilot databases.

Before you "go live" with a multi-site environment, you may want to set up a test environment with your company's data. Follow the steps below to set up a multi-site test environment with transactional replication:

1. Create a single application database and forms database, using the instructions in the Infor ERP SyteLine Installation Guide. Then set up your company's data. (You may already be using this version of Infor ERP SyteLine in a "live" or "test" single-site environment. If so, use that as your initial database. Otherwise, you could use the "demo" application database as your initial database.)

2. Perform a SQL backup of that application database.

3. In SQL, create new application databases with unique names for each new site you want to add. Restore the backed up database over each of the newly created databases.

4. (optional) Create new forms databases using the same backup/restore method. You can use the existing forms database and only back up/restore the application databases for each site if you wish, but any form customizations you make are then applied to both your live and test environments.

5. On the utility server, create client configurations pointing to the new databases with Configuration Manager. From the Start menu, navigate to All Programs>Infor>Tools>Configuration Manager.

6. Log in to each of the new configurations as "sa." You may see warning messages about the user count session being exceeded or the license being invalid. These messages are normal and not a problem at this point.

   a. Run the Change Site utility to rename the old (existing) site ID to the new site ID.

   CAUTION: Read the online help about this utility and follow the directions there before running the utility.

   b. In the License Management form, enter the license for this new site.

   c. In the Sites/Entities form, change the application and forms database names for the new site.

   d. Log out.
7. On the utility server, use the **Service Configuration Manager** to set up monitoring of your new configurations for TaskMan, non-transactional replication, and the application event system. From the **Start** menu, navigate to **All Programs>Infor>Tools>Service Configuration Manager**.

8. On the database server, run the **SyteLine Configuration Wizard** to link all the databases you want in your multi-site environment.

9. Log into each site and set up replication rules and/or shared tables between all the sites, as described in Chapter 5, “Setting Up Replication at Sites and Entities.”
Requirements for Loading Data From Spreadsheets

If you have many sites with similar data to be entered at each site, it may make sense to load the data into the system from a spreadsheet. The spreadsheet method only works well if you have smaller volumes of data. It is much more difficult to deal with errors in spreadsheets when you are trying to load a large number of records at once.

TIP: Consider using Infor Professional Services if you have larger volumes of data to load. Contact your Infor representative for more information.

- Make sure the columns in the spreadsheet exactly match the order of the grid in the form, and that the data is in the format required by the form. The best way to do this is to create several sample records in the SyteLine form and then export them to a spreadsheet. Then use that data as a template for the other rows. Or you may want to create a "demo" database and export the sample data to use as a template.

In the template, you may want to hide columns for data that comes from calculated or read-only fields so that you do not enter data into them accidentally. Do not delete these columns; otherwise the columns will not match up when you paste them back into SyteLine.

- Make sure any supporting data has already been loaded. For example, if you try to load a customer address that includes IN as the state, but a Prov/States record does not yet exist for IN, the system sends a validation error and stops importing.
Exporting Data From a Form to a Spreadsheet

To quickly create a spreadsheet that contains all the rows in the current form’s grid, including the header rows, use this process:

1. In the form’s grid, select the rows (shift-click in the row numbers on the left):

   ![Form Grid Example](image)

   **TIP:** You can use Ctrl-2 to toggle between the grid view and the form view.

2. Type Ctrl-C to copy the rows to the clipboard.

3. Open a spreadsheet and paste the rows into it. Notice that some columns are empty and some are set to a different format than appears in the form (for example, 0’s and 1’s instead of checkboxes).

   ![Spreadsheet Example](image)

   **TIP:** You can also use SyteLine’s Actions>**To Excel** menu option. The spreadsheet then automatically opens in Microsoft Excel. However, this option saves the columns in the order they appear in the IDO collection, which may not be the same order that they appear in the grid.
Importing Data From a Spreadsheet into a Form

1. Make sure the columns in the spreadsheet are in the same order as the columns in the form's grid.

2. In the spreadsheet, select the rows (shift-click in the row numbers on the left).

3. Right-click and select **Copy**.

4. Make sure the form is in "Add" mode - that is, the "Create a New Object" toolbar button is enabled.

5. In the form's grid, click in the left column of the first empty row:

   ![Form Grid Example](image)

6. Select **Edit>Paste Rows Append**. The rows are added in the grid:

   ![Paste Rows Append Example](image)

7. Click the Save button to save the rows.

   The copy will work only if all the information in the rows is valid and in the proper format. Otherwise, you will get data validation errors and the import will stop. See “Requirements for Loading Data From Spreadsheets” on page 115.

   When the system encounters an error, it asks if you want to correct the field. If you answer Yes, the import stops. If you answer No, the system continues pasting the rest of the rows. When it completes, you can correct the rows marked with "ne" in the SyteLine form.
Removing a Site or Entity from an Existing System

NOTE: Be aware that, if you remove a master site, the Multi-Site Vendors form and intranet licensing will no longer be available, since these features depend on having a master site.

For more information on any step, refer to the online help.

1. If the site/entity currently reports to an entity and general ledger activity has been performed at the site, do the following:
   a. Post and consolidate all journals and the ledger for transactions in the current site. Run the Ledger Consolidation activity at each site to calculate the ending balances for every account number at the site and consolidate them up through the old entity hierarchy.
   b. Since the full account balances will be closed out and moved, any balances that are to remain in the old structure must be manually transferred to other sites by journal entries in both sites. Post and consolidate those journal entries.

2. If a site is being removed from a reporting hierarchy (that is, it currently reports to an entity) the Change Reports To utility should be run at the site, with the Reports To field blank.

3. If an entity is being removed from a reporting hierarchy:
   a. Run the Change Reports To utility at sites reporting to that entity, to change the hierarchy so that no sites are reporting to it.
   b. If the entity also reported to a higher-level entity, run the Change Reports To utility at the entity being removed, with the Reports To field blank.

4. Make sure all other users are logged out of the site (or, if you are removing a master site, all users are logged out of all sites on the master sites’ intranet).

5. If the site/entity belongs to an intranet that is sharing tables:
   a. Go to the master site’s Intranet Shared Tables form and unshare all the shared tables. This adds the shared tables back to all of the sites/entities in the intranet.
   b. At the site/entity being removed, go to the Sites/Entities form and change the Intranet value to some other intranet (or make it blank).
   c. If the site being removed is the master site for the shared intranet, log into the master site. On the Intranets form, blank out the Master Site field. This should replicate to all the other sites in the shared intranet.
6. If the site being removed uses intranet licensing, deselect the Intranet Licensing check box on the Sites/Entities form and save the record.

If the site being removed is a master site using intranet licensing, you must also deselect the Intranet Licensing field at all slave sites and then apply a license at each site.

**CAUTION:** Turning Intranet Licensing off at a site requires that a license document be applied to that site. It may also result in incomplete licensing on that site for some user-created objects, because the ModuleMembers records created for new and copied forms will have been created in the master site application database and in the originator's site application database. If Intranet Licensing at a site is disabled, and if it is not the master site or the site from which the new or copy action was originated, then the appropriate ModuleMember licensing records for those user created forms/IDO's will not be present in the application database of that site.

Users will not be able to access sites where you have turned off intranet licensing until you either set up specific licensing for that site, or set up a new master site with intranet licensing and then reselect the Intranet Licensing check box at the master and slave sites.

7. Remove replication rules:
   - from other sites and entities to the site/entity being removed
   - from the site/entity being removed to other sites and entities.

8. If the removed site/entity uses a linked server definition to connect to other sites/entities (see step 9 on page 19), change the linked server setup within SQL Server or with the Configuration Wizard on the database server.

9. Delete the removed site/entity’s record in the Sites/Entities form at the other sites and entities.

Since the Site Admin category is replicated between all sites/entities, removing the site record from one site/entity should remove it from all of the others. Verify this at each site/entity.

You may need to delete data relating to the removed site, so that SyteLine will allow the deletion of the removed site’s records on the Sites/Entities form. If so, an error message displays information about the problem. You can also use SQL queries to review any data that references the site/entity, to make sure you are not leaving databases in a state where orphaned data causes issues with functionality.

Some records for the site are automatically removed by the system. For example, the site’s record is removed from the Site Groups form.

Site records remaining in _all tables should not cause problems with the application. However, they do take up space in the database. See step 14.

10. If the site being removed was the master site, specify a new master site (optional). Log into the site that will be the new master site. On the Intranets form, select the shared intranet. In the Master Site field, select this site to specify it as the master site for the intranet.
11. At the *master site*, delete any references to the removed site in the *Sites/Entities* form’s Link Info tab.

12. In the *removed site/entity*, delete records for the other sites/entities in the *Sites/Entities* form. See the Note above.

13. Regenerate the replication triggers at *all sites/entities*.

14. You may want to use the *Update _All Tables* utility to truncate and repopulate the _all tables, deleting references to the removed site. Or you may want to temporarily preserve the site records in the _all tables for later auditing. If you choose to truncate/repopulate, perform the truncation at all sites/entities first; then perform the repopulation at all sites/entities.

15. If the site/entity was removed from a shared tables intranet, go to the *master site*. Open the *Intranet Shared Tables* form and re-share the shared tables that you unshared in step 5.

16. In the *Service Configuration Manager* on the utility server, if the removed site’s configurations were being monitored by TaskMan or the Event Service, remove it from the list of monitored configurations. If the site’s configuration was the bootstrap configuration for the Replication services or for the Inbound Bus service, specify a different configuration to use.

17. In the *Configuration Manager* on the utility server, remove the site’s configurations from any configuration groups, and remove or edit the configuration definitions.

18. Restart the Infor Framework services on the utility server to pick up the configuration changes.

After removing this site/entity from its current system, you may want to add it to another SyteLine multi-site system.
Upgrading a Multi-Site System

See the *Infor ERP SyteLine Installation Guide* chapter on Upgrading a SyteLine Database.

For converting a SyteLine version 5, 6, or 7 multi-site environment to Infor ERP SyteLine 8, see the *Infor ERP SyteLine Installation Guide*. 
Index

Symbols
  _all tables
    and replication rules 42
  Linking databases 19
  Sharing 44
  Troubleshooting 102
A
  A/P category 74, 75, 96
  A/R category 56, 75, 96
  Account Unit Code 68
  Accounting Periods form 69
  Accounts Payable Parameters form 82
  Accounts Receivable Parameters form 81
  Accounts, inter-entity 65
  Accounts, inter-site 80
  Activate EU VAT Reporting field 74
  ActiveDirectory 50
  Address of company 77
  Administrating all sites from one console 34
  Administrative client configuration 21
  Application database
    Adding configurations 22
    in configuration wizard 13
    Linking, how it works 19
  Application Database to Link 17
  APS
    Documentation 99
    Planning and Scheduling gateway 21
  ApsResyncAllSp 19
  Authorization group, selecting 89
B
  Balance sheet 71
  Bank codes 79
  Bank Reconciliations form 79
  Billing Terms 94
  BODs
    Confirmation 107
    Problem - outbound BODs not sent 106
    Problem - transaction timeout or error processing IDO request 107
  BOMs 97
  Bootstrap site 32
  Business Intelligence documentation 99
C
  Cash Flow Statement 71
  Centralized Order Entry category 56, 74, 75, 96
  Change Reports To Entity form 63
  Change Reports to Entity form 39, 53, 63
  Change Site utility 113
  Changes in Financial Position 71
  Chart of Accounts form 65, 67
  ChartAcctRemoteSp 67
  Checklist 7
  Client, specifying configuration group 36
  Clients, setting up 35
  Commodity Codes 94
  Companies 93
  Company address 77
  Configuration
    Adding for databases 22
    Administrative client 21
    Replication 32
  Configuration group
    Specifying for a client 36
  Configuration groups
    Defining 28
  Configuration Manager 26, 28, 34, 113
  Configuration name, on window title 35
  Configuration Server 26
  Configuration Wizard 39
    Log file 18
    on database server 14, 16, 73
  Confirmation BOD 107
  coparms_all table 83
  Copy Unit Codes to Accounts form 68
  Copy User Table utility 91
  Countries form 74
  Credit Hold Reason Code 81
  CRM 99
  Crystal Reports 21
  CTA Account 65, 78
  Currency Codes form 75
  Currency Rates form 76
  Currency spreadsheet 74, 76
  Currency Translation Date 64
  Currency translation method 67
  Current Fiscal Year 77
  Current Period 69
  Current Routings 97
  Customer Order Lines 97
  Customer Orders 97
  Customer prefix 81
  Customers form 96
  Customers, sharing between sites 96
  Cutoff Date 64
D
  Data Collection documentation 99
  Data import errors 117
  Data load spreadsheets 94
  Database
    Application 13
    Entity 14
    Forms 13
    Linking 16
Name and location  15
  Objects  13
  Server setup  13
  Site  14
Default configuration group  28
Delivery Terms  93
Demo database, using as template  115
Departments  93
Direct IDO URL  51
Discard Cache  34
Distribution Accounts  93
Divisions  93
Domestic currency  75

E
  EAM  11, 99
  EDI  99
  Employee Number  90
  Employees form  97
  Empty Application Database  14
  End user client setup  35
  End User Types  94
  Enter Out of Date Range  87
  Entity Forms authorization group  89
  Ephiphany CRM  99
  Error messages  112
  Error on Replication Errors form  109
  Errors during import from spreadsheet  117
  ESB  50
  Event System  99
  Events spreadsheet  30
  Excel-based toolset for financial reporting  71
  Exchange rate  80
  ExportUETClassSp  105
  External intranet  38, 50

F
  FASB52  67
  FAX  99
  Financial reporting hierarchy setup  63
  Financial Statement Definition Columns form  71
  Financial Statement Definition form  71
  Financial Statement Line Definition form  71
  Financial Statement Output form  71
  Find Replication Setup Issue form  110
  Fixed Asset Class Codes  94
  Flowchart, from planning guide  63
  Forms database  13
  From Site field
    Replication Errors form  109
    Sites/Entities form  53
  
G
  G/L category  56, 67, 69
  GAAP  67
  General Parameters form  74, 77
  GetConfigurations IDO request  36
  
  Global
    Customers  96
    Items  96
    Vendors  96
  Group Authorizations  89
  Group Name  16
  Groups form  89

H
  Hierarchy of reporting  63
  Hierarchy, flowchart  63

I
  IDO Runtime Development Server  112
  Inbound Bus Service  107
  InboundQueue  51
  Income Statement (Profit and Loss)  71
  Infor CSI  106, 107
  Infor DCA  106
  Infor EAM  99
  Infor ERP SyteLine FAX Service  99
  Infor ESB  50
  Infor On-Ramp  106
  Infor PLM  99
  Initialized application database  13, 14
  Inter-entity account numbers  65
  Inter-entity, definition  80
  Inter-Site Parameters form  80
  Interval Type  41, 56, 103
  Intra-entity, definition  80
  Intranet Licensing  59, 87, 91, 119
  Intranet Shared Tables  11
    Form  46
    Setup  44
  Intranets form  38, 45, 50
  Invalid Accounts Only  70
  Invalid Column name UF_xxxx  105
  Inventory/Transfers category  96
  Invoice Length  83
  Item Availability form  89
  Items form  96
  Items, sharing between sites  96

J
  Job routings  97
  Jobs  97
  Journal Entries form  97

L
  Label on Replication Errors form  109
  Language IDs  94
  Ledger Consolidation category  67, 69
  Ledger Consolidation utility  67
  License Document  61
  License Management form  61, 113
  Licensing
    Intranet  59

Infor ERP SyteLine Multi-Site Implementation Guide
Copyright © 2009 Infor
Infor ERP SyteLine Multi-Site Implementation Guide
Copyright © 2009 Infor

Index

Named user 91
Setup 59
Spreadsheet 91
SyteLineAutomation 49
Line on Replication Errors form 109
Link Databases for Multi-Site Use 16
Link Info 39, 44
Linking databases 16
Linking sites 39
Locations 94
Log file
  Configuration wizard 18
  Replication 104
Log Monitor 112
Logging into SyteLine 35
LogMonitor utility 106, 107

M
Manual Replication 95
Master site 11, 44, 45, 51, 59
  Adding vendors 95
  Removing 119
Maximum Number of Databases has been Exceeded (error) 112
Message Queueing 104
MongooseConfigs.xml 28
MSMQ 50, 104
MSMQ instances and listeners 50
Multi-Currency Parameters form 75
Multi-Lingual Ship Via 94
Multi-Lingual Terms 94
Multi-Site Chart Copy form 66
Multi-Site Group 89
Multi-Site Vendors 95, 119

N
Named user licensing 91
Nature of Transaction Codes 93
Non-transactional replication
  Configuration definition 32
  Definition 11
  Setting up 48
  Setting up services 21
  Troubleshooting 104
  User 48
NotesContentShadow table 56

O
Object Authorizations for User form 90
Object Name field, Replication Errors form 109
Objects database 13
Offices 93
Old/New on Replication Errors form 109
Operation Number on Replication Errors form 109
Operation Type on Replication Errors form 109
Order Entry Parameters form 82
Parameters tables 43, 58
parms_all 77
Password Parameters form 88
Performance problems, troubleshooting 104
Planning and Scheduling gateway and server 21
Planning Parameters form 84
PLM 99
Posting Method 80
Prefixes
  Customer 81
  for order entry 83
  for purchasing 83
  Transfer order 84
  Transfer/project BOL 77
  Vendor 82
Price code 80
Price Codes form 93
Price From Originating Site 83
Purchasing, centralized 83
Printers 94
Private Queue 50
Product Codes 93
Project Cost Codes 93
Prov/States form 74
Purchase Order Lines 97
Purchase Orders 97
Purchasing Parameters form 83

Q
Queue Server 50

R
Reason Codes 94
Regenerate Replication Triggers 42, 57, 103
Removing a site 119
repl_user 48, 53
ReplicatedRows3 table 104
Replication
  Disabling 95
  During Data Loads 95
  Non-Transactional, definition 11
  Services, setting up 21
  Transactional, definition 11
  Troubleshooting 102
Replication categories
  A/P 74, 75, 96, 102
  A/R 75, 96, 102
  Bus-Vendor 102
  Centralized Order Entry 74, 75, 96, 102
  Form 41, 56
  G/L 67, 69, 102
  in shared tables 46
  Inventory/Transfers 96, 102
  Journal Builder 102
  Ledger Consolidation 41, 67, 69, 102
  Ledger Detail 103
Planning 103
Purchase Order Builder 103
Shared Currency 74, 75, 103
Site Admin 56, 73, 80, 90, 103
Voucher Builder 96, 103
Replication Document Inbox 106
Replication Document Outbound Cross References form 106
Replication Document Outbox 107
Replication Errors form 104, 109
Replication log files 104
Replication Management form 42, 57, 103
Replication Rules form 41, 56, 102
Replication services
Troubleshooting 104
Replication Tool 107
ReplicationRules spreadsheet 42, 57
Repopulate Tables 43, 58
Report URL 39
Reports To
Account number field in Chart of Accounts 67
CTA account 78
Field on Sites/Entities form 39, 53, 64
Resource Groups 94
Resource Types 94
Resources 94

S
sa user
Defining group for 87
Password 35
Scheduling Shifts 94
Secondary NOTC 93
Service Configuration Manager utility 108
Set Database Site Parameters 15
ShadowValues tables 104
Shared (global) customers, adding 96
Shared (global) items, adding 96
Shared (global) vendors, adding 96
Shared _All Tables 44
Shared Currency category 74, 75
Shift Codes 94
Ship Via Codes 93
Shipping Site 97
Site Admin category 41, 56, 59, 73, 80, 90
Site Description 17
Site group 16
Default for user 89
Default for utilities and reports 77
for user 87
Used for A/P activities 82
Used for A/R activities 81
Site Groups form 17, 73
Site ID 17, 22
Site name, on window title 35
Site table 19
Site, removing 119
site_group table 19
site_live_link table 19
SiteEntity spreadsheet 13, 15, 16, 23
Sites/Entities form 39, 42, 45, 49, 53, 57, 59, 60, 64, 95, 103, 113
SL_Internal user 88
Spreadsheets
Creating for data load 94
Currency 74
Events 30
Exporting data to forms 117
Importing data from forms 116
Licensing 91
ReplicationRules 42, 57
SiteEntity 13, 15, 16, 23
SQL
Backup and restore 113
Linked server error 105
Server Name 17
Username and Password 17
Statement of Cash Flow 71
System performance, troubleshooting 104
System Type field on Sites/Entities form 53
System Types form 49, 53
SyteLine login 35
SyteLine shared folder 39, 52
SyteLineAutomation license 49
T
Table dependencies 93
Task Manager path 52
TaskMan
Installing 21
Monitoring configurations 30
Path 39
Tax Codes 94
Tax Jurisdictions 94
Tax Systems 94
Test environment 11
Setup 113
To Excel menu option 116
Transactional replication
Definition 11
Linked server definition in Enterprise Manager 19
Linking databases 16
Setup 38
Transfer Order Parameters form 84
Transfer/project BOL prefix 77
Transport field on Intranets form 50
Troubleshooting
Performance problems 104
Replication 102
U
UETs 105
Unit Code (1-4) forms 68
unit codes 68
Unit of Measure Codes 94
Unit of Measure Conversions 94
URL 50, 51
User Authorizations 90
User Extended Tables 105
User Modules form 49, 91
User Name, on Sites/Entities form 53
UserNamesRemoteUpdateSp 90
Users form 87, 89
Users, copying to other sites 91
Utility Server setup 21

V
Value on Replication Errors form 109

Vendor Categories 94
Vendor prefix 82
Vendor, sharing between sites 96
Vendors form 96
Verify Reports To Account Report form 70
Voucher Builder category 96

W
Warehouses 93
Whse 90
Work Centers 94
Working Capital 71

X
XSL stylesheets 49